
Th i l ng: 60 ti tờ ượ ếTh i l ng: 60 ti tờ ượ ế

Bài gi ng Tin h c đ i c ngả ọ ạ ươBài gi ng Tin h c đ i c ngả ọ ạ ươ



 Tin h c căn b n (20 ti t)ọ ả ế
 C  b n v  CNTT và máy tính (4 ti t)ơ ả ề ế
 S  d ng h  đi u hành Windows (12 ti t)ử ụ ệ ề ế
 Công ngh  Internet (4 ti t)ệ ế

 Tin h c văn phòng (40 ti t)ọ ế
 S  d ng ph n m m so n th o văn b n MS Word ử ụ ầ ề ạ ả ả
(16 ti t)ế
 S  d ng ph n m m b ng tính đi n t  MS Excel (16 ử ụ ầ ề ả ệ ử
ti t)ế
 S  d ng ph n m m trình chi u MS PowerPoint    (8 ử ụ ầ ề ế
ti t)ế

N I DUNG CH NG TRÌNHỘ ƯƠN I DUNG CH NG TRÌNHỘ ƯƠ



Module 1Module 1   

C  B N V  CÔNG NGH  Ơ Ả Ề ỆC  B N V  CÔNG NGH  Ơ Ả Ề Ệ
THÔNG TIN VÀ MÁY TÍNHTHÔNG TIN VÀ MÁY TÍNH



1/ Khái ni m v  tin h c: ệ ề ọ Tin h c là ngành khoa h c ọ ọ
công ngh  nghiên c u các ph ng pháp, các quá trình ệ ứ ươ
x  lý thông tin m t cách t  đ ng d a trên ph ng ti n ử ộ ự ộ ự ươ ệ
k  thu t là máy tính đi n t .ỹ ậ ệ ử

2/ Máy tính đi n t  (Computer):ệ ử  Là m t thi t b  đi n t  ộ ế ị ệ ử
dùng đ  l u tr  và x  lý thông tin theo các ch ng ể ư ữ ử ươ
trình đ nh tr c do con ng i đ nh ra.ị ướ ườ ị

I/ Các khái ni m c  b nệ ơ ảI/ Các khái ni m c  b nệ ơ ả



II/ Các giai đo n phát tri n c a máy tínhạ ễ ủII/ Các giai đo n phát tri n c a máy tínhạ ễ ủ
 Th  h  th  nh t (1945-1955) máy tính dùng đèn ế ệ ứ ấ
đi n t :ệ ử  Máy tính đ u tiên có tên ầ ENIAC (Electronic 
Numerical Integrator and Computer) n ng kho ng 30 t n ặ ả ấ
(1946)  M .ở ỹ

 Th  h  th  hai (1955-1965) máy tính dúng thi t b  ế ệ ứ ế ị
bán d n:ẫ  Dùng linh ki n m i là Transistor (đ c phòng ệ ớ ượ
thí nghi m Bell phát tri n năm 1948). B  nh  máy tính ệ ể ộ ớ
đ c tăng lên đáng k  và tr  nên nh  g n h n. ượ ể ở ỏ ọ ơ

 Th  h  th  ba (1965-1980) dùng m ch h p tích ế ệ ứ ạ ợ
h p IC: ợ Công ngh  đi n t  gi  đã phát tri n r t nhanh ệ ệ ử ờ ể ấ
cho phép đ t hàng ch c Transistor vào m t v  chung g i ặ ụ ộ ỏ ọ
là con chip. 



 Th  h  th  t  (1980-199x) s  d ng công ngh  ế ệ ứ ư ử ụ ệ
(VLSI): Vào nh ng năm 80 công ngh   (VLSI Very ữ ệ
Large Scale Integrator) ra đ i cho phép tích h p trong ờ ợ
m t con chip hàng tri u Transitor khi n cho máy tính ộ ệ ế
tr  nên nh  h n, nhanh h n v i t c đ  hàng tri u phép ở ỏ ơ ơ ớ ố ộ ệ
tính m t giây là n n t ng cho chi c máy tính PC ộ ề ả ế
(Personal Computer) ngày nay.

 Năm 1981, IBM gi i thi u máy tính cá nhân PC ớ ệ
(Personal Computer) đ u tiên.ầ

II/ Các giai đo n phát tri n c a máy tính (tt)ạ ễ ủII/ Các giai đo n phát tri n c a máy tính (tt)ạ ễ ủ



1/ Khái ni m v  thông tin:ệ ề  B t c  thông báo hay m t tín ấ ứ ộ
hi u gì đ u đ c coi là m t thông tin. Vi c trao đ i hay ệ ề ượ ộ ệ ổ
ti p nh n thông tin theo nghĩa thông th ng đ c con ế ậ ườ ượ
ng i trao đ i theo nhi u cách khác nhau (thính giác, ườ ổ ề
th  giác, kh u giác …).ị ứ

2/ Bi u di n thông tin trong máy tínhể ễ : Do máy tính 
đ c ch  t o d a trên các thi t b  đi n t  ch  có hai ượ ế ạ ự ế ị ệ ử ỉ
tr ng thái đóng và m , t ng ng v i hai s  0 và 1. ạ ở ươ ứ ớ ố
Nên đ  l u tr  thông tin trong máy, máy tính dùng h  ể ư ữ ệ
đ m nh  phân (Binary) t c là h  đ m đ c bi u di n ế ị ứ ệ ế ượ ể ễ
v i hai ch  s  0 và 1.ớ ữ ố

3/ Các đ n v  đo thông tin: ơ ị
  Đ n v  c  s : Bit (0 ho c 1)ơ ị ơ ở ặ

III/ Thông tin và bi u di n thông tin trong máy tính ể ễIII/ Thông tin và bi u di n thông tin trong máy tính ể ễ



 Đ n v  c  b n:  Byte: 1 Byte = 8 Bitơ ị ơ ả

 Các b i s  c a Byte:ộ ố ủ
 Kilobyte: 1 KB = 210 = 1024 Byte 
 Megabyte: 1 MB = 1024 KB 
 Gigabyte: 1GB = 1024 MB 
 Terabyte: 1TB= 1024 GB

3/ 3/ Các đ n v  đo thông tin (tt)ơ ịCác đ n v  đo thông tin (tt)ơ ị



 H  10 sang h  2:ệ ệ  Th c hi n liên ti p các phép chia ự ệ ế
cho 2 cho đ n khi th ng s  b ng 0. S  nh  phân ế ươ ố ằ ố ị
t ng ng là các k t qu  c a phép d  chia cho 2 l y ươ ứ ế ả ủ ư ấ
t  đáy lên.ừ

 H  2 sang h  10:ệ ệ
 Xét s  trong h  c  s  2 v i bi u di n nh  sau:ố ệ ơ ố ớ ể ễ ư
N2=dndn-1…d1d0

Khi đó trong h  c  s  10 s  N s  là:ệ ơ ố ố ẽ
N10=dn*2n+dn-1*2n-1+…+d1*21+d0*20

4/ Chuy n đ i gi a các h  đ mể ổ ữ ệ ế4/ Chuy n đ i gi a các h  đ mể ổ ữ ệ ế



H  th ng máy tính bao g m hai h  th ng con:ệ ố ồ ệ ố
1/ Ph n c ng:ầ ứ  Bao g m toàn b  máy  và các thi t b  ồ ộ ế ị

ngo i vi là các thi t b  đi n t  đ c  k t h p v i ạ ế ị ệ ử ượ ế ợ ớ
nhau. Nó th c hi n ch c năng x  lý thông tin  m c ự ệ ứ ử ở ứ
th p nh t t c là các tín hi u nh  phân.ấ ấ ứ ệ ị

2/ Ph n m m:ầ ề  Là các ch ng trình (Programs) do ng i ươ ườ
s  d ng t o ra đi u khi n các ho t đ ng ph n c ng ử ụ ạ ề ể ạ ộ ầ ứ
c a máy tính đ  th c hi n các nhi m v  ph c t p ủ ể ự ệ ệ ụ ứ ạ
theo yêu c u c a ng i s  d ng. Ph n m m c a ầ ủ ườ ử ụ ầ ề ủ
máy tính đ c phân làm 2 lo i: Ph n m m h  th ng ượ ạ ầ ề ệ ố
(System Software) và ph n m m ng d ng ầ ề ứ ụ
(Applications Software).

IV/ C u trúc c  b n c a máy tính ấ ơ ả ủIV/ C u trúc c  b n c a máy tính ấ ơ ả ủ



1/ Máy tính l n (Mainframe): ớ Là lo i máy tính có kích ạ
th c v t lý l n, m nh, ph c v  tính toán ph c t p.ướ ậ ớ ạ ụ ụ ứ ạ

V/ Các lo i máy tínhạV/ Các lo i máy tínhạ



V/ Các lo i máy tính (tt)ạV/ Các lo i máy tính (tt)ạ
2/ Siêu máy tính (Super Computer): Là m t h  th ng ộ ệ ố
g m nhi u máy l n ghép song song có t c đ  tính toán ồ ề ớ ố ộ
c c kỳ l n và th ng dùng trong  các lĩnh v c đ c bi t, ự ớ ườ ự ặ ệ
ch  y u trong quân s  và vũ tr . Siêu máy tính Deep ủ ế ự ụ
Blue là m t trong nh ng chi c thu c lo i này. ộ ữ ế ộ ạ



V/ Các lo i máy tính (tt)ạV/ Các lo i máy tính (tt)ạ
3/ Máy tính cá nhân PC ( Personal Computer): Còn g i ọ
là máy tính đ  bàn (Desktop).ể  H u h t các máy tính đ c ầ ế ượ
s  d ng trong các văn phòng, gia đình. ử ụ



V/ Các lo i máy tính (tt)ạV/ Các lo i máy tính (tt)ạ
4/ Máy tính xách tay (Laptop): Máy tính Laptop là tên 
c a m t lo i máy tính nh , g n có th  mang đi theo ủ ộ ạ ỏ ọ ể
ng i, có th  ch y b ng pin. M t tên g i khác ườ ể ạ ằ ộ ọ
“Notebooks” ch  m t Laptop nh .ỉ ộ ỏ  

S1

S5



V/ Các lo i máy tính (tt)ạV/ Các lo i máy tính (tt)ạ

S1

S5

5/ Máy tính b  túi (Pocket PC):ỏ  Hi n nay, thi t b  k  ệ ế ị ỹ
thu t s  cá nhân (PDA) có ch c năng r t phong phú, nh  ậ ố ứ ấ ư
ki m tra e-mail, ghi chú ng n g n, xem phim, l t ể ắ ọ ướ
Internet, nghe nh c hay so n tài li u văn phòng… nhi u ạ ạ ệ ề
máy hi n nay đ c tích h p ch c năng đi n tho i di ệ ượ ợ ứ ệ ạ
đ ng.ộ



VI/ C U T O C A M T MÁY TÍNH CÁ NHÂN Ấ Ạ Ủ ỘVI/ C U T O C A M T MÁY TÍNH CÁ NHÂN Ấ Ạ Ủ Ộ

S1

S  đ  mô t  các b   ph n c  b n trong m t máy ơ ồ ả ộ ậ ơ ả ộ
tính cá nhân:
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1/ Thi t b  nh p:ế ị ậ  Là thi t b  có nhi m v  đ a thông tin ế ị ệ ụ ư
vào máy tính đ  x  lý.ể ử

 Các thi t b  nh p thông d ng:ế ị ậ ụ  Chu t, bàn phím, máy ộ
quét, webcame.

VI/ C U T O C A M T MÁY TÍNH CÁ NHÂN (tt)Ấ Ạ Ủ ỘVI/ C U T O C A M T MÁY TÍNH CÁ NHÂN (tt)Ấ Ạ Ủ Ộ



2/ Thi t b  x  lý:ế ị ử  X  lý thông tin, đi u khi n ho t đ ng ử ề ể ạ ộ
máy tính. Thi t b  x  lý bao g m: bo m ch ch , b  vi ế ị ử ồ ạ ủ ộ
x  lý.ử

VI/ C U T O C A M T MÁY TÍNH CÁ NHÂN (tt)Ấ Ạ Ủ ỘVI/ C U T O C A M T MÁY TÍNH CÁ NHÂN (tt)Ấ Ạ Ủ Ộ



 Kh i x  lý trung tâm là b  não c a máy tính, đi u ố ử ộ ủ ề
khi n m i Ho t đ ng c a máy tính bao g m 4 thành ể ọ ạ ộ ủ ồ
ph n chính:ầ

 Kh i đi u khi nố ể ể  (Control Unit): Xác đ nh và s p x p các ị ắ ế
l nh theo th  t  đi u khi n trong b  nh .ệ ứ ự ề ể ộ ớ

 Kh i tính toánố  (Arthmetic Logical Unit): Là n i th c hi n ơ ự ệ
h u h t các thao tác tính toán c a toàn b  h  th ng nh : ầ ế ủ ộ ệ ố ư
+, -, *, /, >, <…

 Đ ng hồ ồ (Clock): Không mang theo nghĩa đ ng h  thông ồ ồ
th ng, mà là b  ph n phát xung nh p nh m đ ng b  hoá ườ ộ ậ ị ằ ồ ộ
s  ự Ho t đ ngạ ộ  c a CPU.ủ

 Thanh ghi (Register):  Là n i l u gi  t m th i các ch  th  ơ ư ữ ạ ờ ỉ ị
t  b  nh  trong khi chúng đ c x  lý. T c đ  truy xu t ừ ộ ớ ượ ử ố ộ ấ
thông tin n i đây là nhanh nh t.ơ ấ

 CPU là m t b  ph n quan tr ng nh t trong máy tính, ộ ộ ậ ọ ấ
quy đ nh t c đ  c a máy tính.ị ố ộ ủ  

B  x  lý trung tâm CPU (Central Processing Unit)ộ ửB  x  lý trung tâm CPU (Central Processing Unit)ộ ử



3/ B  nh  máy tính (Thi t b  l u tr ): ộ ớ ế ị ư ữ Đ c dùng đ  ượ ể
l u tr  thông tin và d  li u. B  nh  máy tính đ c ư ữ ữ ệ ộ ớ ượ
chia làm 2 lo i: B  nh  trong và b  nh  ngoài.ạ ộ ớ ộ ớ

3.1/ B  nh  trong (b  nh  trong g n tr c ti p vào bo m ch ộ ớ ộ ớ ắ ự ế ạ
ch ): ủ Là n i l u gi  ch ng trình và x  lý thông tin  ch  y u ơ ư ữ ươ ử ủ ế
là d i d ng nh  phân. Có hai lo i b  nh  trong là RAM và ướ ạ ị ạ ộ ớ
ROM. 

 RAM (Random Access Memory): Hay B  nh  truy c p ộ ớ ậ
ng u nhiên: ẫ Là thi t b  ế ị l u tr  ư ữ d  li u t m th iữ ệ ạ ờ  trong quá trình 
máy tính làm vi cệ , d  li u s  b  m t vĩnh vi n khi không còn ữ ệ ẽ ị ấ ễ
ngu n đi n cung c p. ồ ệ ấ

VI/ C U T O C A M T MÁY TÍNH CÁ NHÂN (tt)Ấ Ạ Ủ ỘVI/ C U T O C A M T MÁY TÍNH CÁ NHÂN (tt)Ấ Ạ Ủ Ộ

 Máy tính s  ch y nhanh ẽ ạ
h n n u có nhi u RAM. ơ ế ề



 ROM (Read Only Memory): B  nh  ch  đ c (ROM) là m t ộ ớ ỉ ọ ộ
lo i chíp nh  đ c bi t đ c thi t l p t  khi s n xu t máy, nó ạ ớ ặ ệ ượ ế ậ ừ ả ấ
l u tr  các ph n m m có th  đ c nh ng không th  vi t lên ư ữ ầ ề ể ọ ư ể ế
đ c. Thông tin không b  m t khi t t máy.ượ ị ấ ắ

B  nh  trong (tt)ộ ớB  nh  trong (tt)ộ ớ



3.2/ B  nh  ngoài:ộ ớ  Là các thi t b  l u tr  g n gián ti p vào bo ế ị ư ữ ắ ế
m ch ch  thông qua dây cáp d  li u, các khe c m m  r ng ạ ủ ữ ệ ắ ở ộ
…

 B  nh  ngoài là n i l u tr  h  đi u hành, ph n m m ng ộ ớ ơ ư ữ ệ ề ầ ề ứ
d ng, d  li u c a máy tính.ụ ữ ệ ủ

 B  nh  ngoài bao g m  c ng, đĩa m m, CD,  c ng USB…ộ ớ ồ ổ ứ ề ổ ứ

3/ B  nh  máy tính (tt)ộ ớ3/ B  nh  máy tính (tt)ộ ớ



4/ Thi t b  xu tế ị ấ4/ Thi t b  xu tế ị ấ
 Các thi t b  xu t dùng đ  hi n th  k t qu  x  lý c a máy tính. ế ị ấ ể ể ị ế ả ử ủ
M t s  thi t b  tiêu bi u bao g m: Màn hình, máy in, máy chi u, ộ ố ế ị ể ồ ế
loa…



VII/ Ph n m m (Software)ầ ềVII/ Ph n m m (Software)ầ ề
1/ Ph n m m h  th ng (System Software): ầ ề ệ ố Bao g m H  đi u ồ ệ ề
hành (Operating System), các ph n m m đi kèm thi t b  ph n ầ ề ế ị ầ
c ng (Driver).ứ

 Khái ni m h  đi u hành:ệ ệ ề  Là m t h  th ng ph n m m đi u ộ ệ ố ầ ề ề
hành m i ọ Ho t đ ngạ ộ  c  b n c a máy tính và các thi t b  ngo i ơ ả ủ ế ị ạ
vi. Nó là n n t ng cho các ng d ng và chu ng trình ch y trên ề ả ứ ụ ơ ạ
nó. Các ch c năng c  b n c a HĐH:ứ ơ ả ủ

 Đi u khi n vi c ề ể ệ Ho t đ ngạ ộ  c a máy tính và các thi t b  ngo i vi. ủ ế ị ạ

 T  ch c c p phát và thu h i vùng nh .ổ ứ ấ ồ ớ

 Đi u khi n vi c th c thi ch ong trình. ề ể ệ ự ư

 Qu n lý vi c  truy  xu t thông tin.ả ệ ấ

 M t s  HĐH thông d ng:ộ ố ụ



 MS DOS: H  đi u hành đ n nhi m, làm vi c v i giao di n ệ ề ơ ệ ệ ớ ệ
dòng l nh.ệ

 Các phiên b n c a h  đi u hành Windows:ả ủ ệ ề
 Windows 3.x, Windows 95, Windows 98, Windows Me.
 Windows 2000 Pro, Windows XP, Windows Vista.
 Windows NT, Windows 2000 Server, Windows 2003 

Server: dành riêng cho máy ch  - h  đi u hành m ng.ủ ệ ề ạ
 Ngoài ra còn có các h  đi u hành: Linux, Unix, OS/2ệ ề

1/ Ph n m m h  th ng (tt)ầ ề ệ ố1/ Ph n m m h  th ng (tt)ầ ề ệ ố



2/ Ph n m m ng d ngầ ề ứ ụ2/ Ph n m m ng d ngầ ề ứ ụ
 Ph n m m ng d ng:ầ ề ứ ụ  Là các ch ng trình đ c thi t k  ươ ượ ế ế
nh m ph c v  nhu c u s  d ng c a con ng i đ  có th  hoàn ằ ụ ụ ầ ử ụ ủ ườ ể ể
thành m t hay nhi u công vi c nào đó. ộ ề ệ



1/   Virus máy tính là gì? Virus máy tính là m t ch ng ộ ươ
trình ph n m m, và ch ng trình này đ c thi t k  ầ ề ươ ượ ế ế
đ  có th  t  mình làm nh ng vi c mà ng i vi t ra ể ể ự ữ ệ ườ ế
nó đã đ nh tr c. Đ c đi m đ c tr ng c a Virus là ị ướ ặ ể ặ ư ủ
kh  năng t  nhân b n.ả ự ả

 Virus có kh  năng phá h ng ph n m m, xóa s ch d  ả ỏ ầ ề ạ ữ
li u, ăn c p m t kh u…ệ ắ ậ ẩ

VIII/ Virus máy tínhVIII/ Virus máy tính



 Cài ph n m m di t Virus BKAV, D32, Norton Anti ầ ề ệ
Virus, Symatec.

 Quét Virus tr c khi s  d ng các đĩa m m, USB.ướ ử ụ ề
 Sao l u d  li u th ng xuyên.ư ữ ệ ườ

2/ Phòng ch ng Virusố2/ Phòng ch ng Virusố



Module 2Module 2   

S  D NG H  ĐI U HÀNH Ử Ụ Ệ ỀS  D NG H  ĐI U HÀNH Ử Ụ Ệ Ề
WINDOWSWINDOWS



1/ GI I THI U H  ĐI U HÀNH WINDOWS: Ớ Ệ Ệ Ề H  đi u ệ ề
hành Windows là h  đi u hành đ cệ ề ượ  hãng Microsoft 
phát tri n theo ý t ng giao ti p ng i-máy qua các ể ưở ế ườ
c a s  ch a bi u t ng nên ng i dùng có th  d  ử ổ ứ ể ượ ườ ể ễ
dàng thao tác b ng bàn phím hay chu t máy tính.ằ ộ

 Windows là m t h  đi u hành đa nhi m, t c là trong ộ ệ ề ệ ứ
cùng m t th i đi m ng i dùng có th  m  đ c ộ ờ ể ườ ể ở ượ
nhi u ch ng trình cùng m t lúc tùy theo b  nh  c a ề ươ ộ ộ ớ ủ
máy mình đang s  d ng.ử ụ

 HĐH Windows dùng các c a s  đ  giao ti p v i ử ổ ể ế ớ
ng i s  d ng.ườ ử ụ

 C a s  đ u tiên là màn hình n n Desktop. Các c a ử ổ ầ ề ử
s  ti p theo s  n m trên màn hình Desktop.ổ ế ẽ ằ

Bài 1: CÁC KHÁI NI M C  B N V  HĐH WINDOWSỆ Ơ Ả ỀBài 1: CÁC KHÁI NI M C  B N V  HĐH WINDOWSỆ Ơ Ả Ề



2/ C u trúc c a m t Windowấ ủ ộ2/ C u trúc c a m t Windowấ ủ ộ
Title 
barMenu Bar

Tools bar

1. Thanh tiêu đ  (Title Bar) ch a ề ứ
bi u t ng, tiêu đ  c a s , nút ể ượ ề ử ổ
thu nh , phóng to, t t c a s .ỏ ắ ử ố

2. Thanh th c đ n l nh (Menu bar) ự ơ ệ
ch a các l nh đ  thao tác.ứ ệ ể

3. Thanh công c  (Tool bar): ch a ụ ứ
các nút l nh giúp ng i s  d ng ệ ườ ử ụ
thao tác nhanh v i ng d ng.ớ ứ ụ

4. Thanh đ a ch  (Address bar): hi n ị ỉ ể
th  đ ng d n c a th  m c.ị ườ ẫ ủ ư ụ

5. Thanh tr ng thái (Status bar): hi n ạ ể
th  thông tin h  tr  ng i s  d ngị ỗ ợ ườ ử ụ



3/ C u trúc l u trấ ư ữ3/ C u trúc l u trấ ư ữ
 T t c  d  li u c a máy ấ ả ữ ệ ủ
tính đ u l u tr  trong các ề ư ữ
thi t b  l u tr  ngoài.ế ị ư ữ

 C a s  My Computer ử ổ
qu n lý t t c  các thi t b  ả ấ ả ế ị
l u tr  ngoài: đĩa m m, ư ữ ề
đĩa c ng, đĩa CD, DVD, ứ
USB …



 Quy c đ t tên các  ướ ặ ổ
đĩa:

 A, B: đĩa m mề
 C:, D:, .. phân vùng  c ng.ổ ứ
 Các ký t  ti p theo cho  ự ế ổ

CD, USB,… tùy thu c vào ộ
s  l ng đĩa g n vào máy…ố ượ ắ

3/ C u trúc l u tr  (tt)ấ ư ữ3/ C u trúc l u tr  (tt)ấ ư ữ



4/ Khái ni m t p tin (File)ệ ệ4/ Khái ni m t p tin (File)ệ ệ
 Là t p h p các thông tin có cùng b n ch t và đ c l u ậ ợ ả ấ ượ ư
tr  nh  m t đ n v  l u tr  d  li u trên các v t mang ữ ư ộ ơ ị ư ữ ữ ệ ậ
thông tin (đĩa t , băng t , USB....), tùy theo t ng ki u t p ừ ừ ừ ể ệ
mà n i dung ch a đ ng trong đó s  khác nhau.ộ ứ ự ẽ

 T p tin có 3 đ c tr ng chính là: Tên t p, kích th c và ệ ặ ư ệ ướ
ngày tháng c p nh t.ậ ậ

 Tên t p (Name)ệ  : G m có 2 ph n là ồ ầ Tên t p và ph n ệ ầ
m  r ngở ộ

 Tên t p:ệ  Là m t chu i các ký t , không ch a ký t  đ c bi t ộ ỗ ự ứ ự ặ ệ
nh : *  ?  \  /  “  :  < >. V i h  đi u hành MSDOS t i đa là 8 ký ư ớ ệ ề ố
t  và không ch a kho ng tr ng, v i h  đi u hành Windows t i ự ứ ả ố ớ ệ ề ố
đa là 255 ký t .ự  



 Ph n m  r ng:ầ ở ộ  Là cách vi t t t cho ki u t p tin, t i đa là 3 ế ắ ể ệ ố
ký t , gi a chúng không ch a kho ng tr ng và ký t  đ c ự ữ ứ ả ố ự ặ
bi t. Ph n này th ng do h  th ng t  quy đ nh và đ c tr ng ệ ầ ườ ệ ố ự ị ặ ư
cho t ng ki u t p. Ph n m  r ng đ  xác đ nh t p tin đó ừ ể ệ ầ ở ộ ể ị ậ
đ c t o ra t   ng d ng nào, ho c đ c ng d ng nào s  ượ ạ ừ ứ ụ ặ ượ ứ ụ ử
d ng.ụ  Ph n m  r ng ngăn cách v i tên t p b ng m t d u ầ ở ộ ớ ệ ằ ộ ấ
ch m (.).ấ

 M t s  ki u t p tin thông d ng: .exe – t p tin t  thi hành, ộ ố ể ậ ụ ậ ự
.doc – t p tin văn b n Word, .txt t p tin văn b n s  c p, .mp3 ậ ả ậ ả ơ ấ
– t p tin nh c nén, .jpg – t p tin hình nh …ậ ạ ậ ả

4/ Khái ni m t p tin (tt)ệ ệ4/ Khái ni m t p tin (tt)ệ ệ



 Đ  t o thu n l i cho quá ể ạ ậ ợ
trình l u tr  và truy xu t ư ữ ấ
d  li u ữ ệ Windows cho 
phép t  ch c các d  li u ổ ứ ữ ệ
đ c l u d i  d ng cây ượ ư ướ ạ
th  m c. V i m i  đĩa ư ụ ớ ỗ ổ
là m t th  m c g c  ộ ư ụ ố
trong đó ch a các t p tin ứ ậ
ho c các th  m c con. ặ ư ụ
B n thân trong m i th  ả ỗ ư
m c con có th  ch a ụ ể ứ
trong nó các t p tin và ậ
các th  m c con khác. ư ụ

5/ Khái ni m th  m c (Folder)ệ ư ụ5/ Khái ni m th  m c (Folder)ệ ư ụ



 Bi u t ng c a th  m c là màu vàng.ể ượ ủ ư ụ
 Th  m c không có ph n m  r ng.ư ụ ầ ở ộ
 Các  đĩa trong c a s  My Computer là các th  m c ổ ử ổ ư ụ

g c qu n lý các th  m c và t p tin.ố ả ư ụ ậ
 Th  m c con là th  m c n m trong th  m c khác.ư ụ ư ụ ằ ư ụ  
 Th  m c hi n hành là th  m c đang làm vi c.ư ụ ệ ư ụ ệ  

5/ Khái ni m th  m c (tt)ệ ư ụ5/ Khái ni m th  m c (tt)ệ ư ụ



 Shortcut là m t t p ộ ậ
tin đ c bi t ch  ặ ệ ỉ
ch a đ ng đ n ứ ườ ế
m t t p tin, ho c ộ ậ ặ
m t th  m c.ộ ư ụ

 Shortcut dùng đ  ể
truy c p  nhanh đ n ậ ế
m t t p tin, th  ộ ậ ư
m c.ụ

 Bi u t ng c a l i ể ượ ủ ố
t t luôn có hình mũi ắ
tên đ c tr ng đi ặ ư
kèm.

6/ Khái ni m l i t t (Shortcut)ệ ố ắ6/ Khái ni m l i t t (Shortcut)ệ ố ắ



 Space bar (dài nh t):ấ  t o 1 ký t  tr ng.ạ ự ố
  (Back Space): xóa v  tr c 1 ký t .ề ướ ự
 Delete: xóa v  sau 1 ký t  (n m bên ph i con tr ).ề ự ằ ả ỏ
 Windows: m  Start Menu.ở
 Caps Look: b t/t t ch  đ  gõ ch  hoa.ậ ắ ế ộ ữ
 Shift: gõ phím ph  (ký t  trên đ u) trên phím 2 ch c ụ ự ầ ứ

năng.

7/ Các phím c  b n trên bàn phímơ ả7/ Các phím c  b n trên bàn phímơ ả



8/ M t s  ch c năng c a chu tộ ố ứ ủ ộ8/ M t s  ch c năng c a chu tộ ố ứ ủ ộ

  Nh n đ n:ấ ơ  ch n 1 ọ
đ i t ng (nút bên ố ượ
trái), th c hi n 1 l nh ự ệ ệ
trên menu.

  Nh n đúp:ấ  m  m t ở ộ
c a s  (nút bên trái)ử ổ

  Nh n ph i:ấ ả  hi n ệ
menu ng  c nh c a ữ ả ủ
các đ i t ng.ố ượ

  Bi lăn: cu n màn ộ
hình làm vi c.ệ



 Mũi tên tr ngắ : tr ng thái bình th ng.ạ ườ
 Đ ng h  cát:ồ ồ  Đang b n th c hi n m t l nh nào đó.ậ ự ệ ộ ệ
 Mũi tên 2 chi u (màu đen):ề  thay đ i kích th c.ổ ướ
 Mũi tên 4 chi u (màu đen):ề  ch n, di chuy n v  trí.ọ ể ị

Các d ng con tr  chu tạ ỏ ộCác d ng con tr  chu tạ ỏ ộ



9/ Kh i đ ng & T t máyở ộ ắ9/ Kh i đ ng & T t máyở ộ ắ
 Kh i đ ng:ở ộ  Nh n nút ấ
Power (l n nh t) trên thùng ớ ấ
máy. 

 T t máy:ắ  Vào Start – 
Shutdown (Turn Off). Ch n ọ
Shutdown (Turn Off) trong 
h p tho i.ộ ạ



Câu 1: Phát bi u nào sau đây không chính xác v  tên ể ề
các  đĩa trong My Computer.ổ

a) Đĩa m m luôn có tên là A:ề
b) Đĩa CD luôn có tên là E:

c) Đĩa c ng luôn b t đ u t  C:ứ ắ ầ ừ
d) Tên B: Không dùng đ  đ t tên cho các  c ng, USB.ể ặ ổ ứ

Câu 2: Tên ti ng Vi t nào sau không trùng v i tên ti ng ế ệ ớ ế
Anh dùng ch  các thành ph n m t Window.ỉ ầ ộ

a) Title bar: thanh tiêu đ .ề
b) Tools bar: thanh th c đ n l nh.ự ơ ệ
c) Scroll bar: thanh cu n.ộ
d) Status bar: thanh tr ng tháiạ

Câu h i và bài t pỏ ậCâu h i và bài t pỏ ậ



Câu h i và bài t p (tt)ỏ ậCâu h i và bài t p (tt)ỏ ậ
Câu 3: Đ i t ng nào trong các đ i t ng sau tr c ti p ố ượ ố ượ ự ế

ch a d  li u c a máy tính.ứ ữ ệ ủ

a) Th  m c - folder.ư ụ

b)  đĩa – driveỔ

c) T p tin – file.ậ

d) B  vi x  lý - CPU.ộ ử

Câu 4: HĐH Windows l u tr  trên thi t b  nào trong các ư ữ ế ị
thi t b  sau?ế ị

a) RAM c) Đĩa m mề

b) ROM d) Đĩa c ngứ



Bài 2Bài 2

  THAO TÁC V I C A SỚ Ử ỔTHAO TÁC V I C A SỚ Ử Ổ



 Trên màn hình Dekstop: Nh n ấ
đúp vào các bi u t ng.ể ượ

 Trên Start Menu: Vào menu 
Programs. Kích chu t vào ng ộ ứ
d ng.ụ

 C a s  Runử ổ : Nh p tên c a ng ậ ủ ứ
d ng c n ch y. Nh n OK. Ví d : ụ ầ ạ ấ ụ
winword, Excel, notepad, calc, 
mspaint.

1/ Kh i đ ng các ng d ngở ộ ứ ụ1/ Kh i đ ng các ng d ngở ộ ứ ụ



 Kích chu t vào tiêu đ  c a s  trên thanh tác v  ộ ề ử ổ ụ
(Taskbar)

 Dùng t  h p phím Alt + Tab.ổ ợ

2/ Chuy n đ i qua l i gi a các c a sể ổ ạ ữ ử ổ2/ Chuy n đ i qua l i gi a các c a sể ổ ạ ữ ử ổ



3/ Thu nh  c a sỏ ử ổ3/ Thu nh  c a sỏ ử ổ
 Nh n nút _ (Minimize) trên thanh tiêu đ  c a c a s .ấ ề ủ ử ổ
 Ho c kích ph i trên tiêu đ  c a s . Ch n Minimize.ặ ả ề ử ổ ọ
 Windows + D: thu nh  t t c  các c a s .ỏ ấ ả ử ổ



4/ Phóng to c a sử ổ4/ Phóng to c a sử ổ
 Nh n nút Maximize trên thanh tiêu đ  (Title bar).ấ ề
 Kích chu t ph i trên thanh tiêu đ . Ch n Maximize.ộ ả ề ọ
 Ho c kích đúp chu t và thanh tiêu đ .ặ ộ ề



 Nh n nút Close (X) trên thanh tiêu đ .ấ ề
 Nh n t  h p phím Alt + F4.ấ ổ ợ
 Kích ph i trên tiêu đ n c a s . Ch n Close.ả ề ử ổ ọ
 Vào menu File – ch n Close.ọ

5/ Đóng c a sử ổ5/ Đóng c a sử ổ



6/ S  d ng phím t tử ụ ắ6/ S  d ng phím t tử ụ ắ
 Nh n phím F10 đ  kích ho t th c đ n l nh c a ng ấ ể ạ ự ơ ệ ủ ứ

d ng b t kỳ.ụ ấ
 Dùng t  h p phím ổ ợ Alt + Ký t  g ch chânự ạ  trên menu, 

nút nh n, … đ  th c hi n l nh thay cho chu t.ấ ể ự ệ ệ ộ
 Trên menu: dùng ký t  g ch chân đ  th c hi n l nh.ự ạ ể ự ệ ệ



7/ S p x p các c a sắ ế ử ổ7/ S p x p các c a sắ ế ử ổ
 M  nhi u c a s .ở ề ử ổ
 Nh p ph i chu t trên thanh Taskbar và ch n m t ấ ả ộ ọ ộ

trong các ki u s p x p: S p so le, s p theo hàng ể ắ ế ắ ắ
ho c s p theo c t.ặ ắ ộ



Bài 3Bài 3

LÀM VI C V I MÀN Ệ ỚLÀM VI C V I MÀN Ệ Ớ
HÌNH N N DESKTOPỀHÌNH N N DESKTOPỀ



1/ C u trúc Desktopấ1/ C u trúc Desktopấ
 Các bi u t ng m c đ nh:ể ượ ặ ị

 My Documents: Th  m c dành riêng c a ng i ư ụ ủ ườ
dùng.

 My Computers: Qu n lý các  đĩa.ả ổ
 My Networks Place: Truy c p tài nguyên trên ậ

m ng n i b .ạ ộ ộ
 Recycle Bin: Thùng rác
 Internet Explorer: Truy c p Internet.ậ

 Thanh tác v  (ụ Taskbar): qu n lý các c a s .ả ử ổ
 Start Menu: Ch a các menu liên k t đ n các ứ ế ế

ng d ng, các ti n ích khác c a HĐH…ứ ụ ệ ủ



2/ S  d ng Start Menuử ụ2/ S  d ng Start Menuử ụ
2.1/ Thao tác v i Start ớ
Menu:

 Nh n phím Windows, ấ
ho c kích chu t vào nút ặ ộ
Start đ  kích ho t.ể ạ

 Di chuy n chu t (ho c ể ộ ặ
phím mũi tên) đ  ch n.ể ọ

 Kích chu t (ho c nh n ộ ặ ấ
Enter) đ  th c hi n l nh.ể ự ệ ệ



 Click ph i trên Taskbar. Ch n ả ọ Properties.
 Show small icon in Start Menu: hi n th  các bi u ể ị ể

t ng d ng nh  nh t trên Start Menu.ượ ạ ỏ ấ

2.2/ Tùy bi n Start Menuế2.2/ Tùy bi n Start Menuế



3/ S  d ng Taskbarử ụ3/ S  d ng Taskbarử ụ

 Taskbar dùng đ  qu n lý các c a s  ( ng d ng) ể ả ử ổ ứ ụ
đang ho t đ ng trên máy.ạ ộ

 Taskbar có th  n m  4 biên c a màn hình Desktop.ể ằ ở ủ
 Kích th c c a Taskbar có th  thay đ i b i ng i s  ướ ủ ể ổ ở ườ ử

d ng.ụ



3.1/ Tùy bi n Taskbarế3.1/ Tùy bi n Taskbarế
 Kích ph i trên Taskbar. Ch n ả ọ Properties.
 Auto Hide: Ch  đ  t  đ ng n Taskbar khi làm vi c ế ộ ự ộ ẩ ệ

v i c a s .ớ ử ổ
 Always top: Luôn hi n th  Taskbar lên trên cùng.ể ị



3.2/ Tùy bi n khay h  th ngế ệ ố3.2/ Tùy bi n khay h  th ngế ệ ố
 Kích ph i trên khay h  th ng. Ch n ả ệ ố ọ Properties.
 Show Clock: hi n th  đ ng h .ể ị ồ ồ



4/ Thay đ i màn hình n nổ ề4/ Thay đ i màn hình n nổ ề
 Kích ph i t i kho ng ả ạ ả

tr ng trên Desktop. Ch n ố ọ
Properties.

 Ch n th  Background ọ ẻ
(Desktop)

 Ch n 1 hình trong danh ọ
sách bên d i.ướ

 Nh n nút ấ Browse đ  tìm ể
ch n hình l u  n i ọ ư ở ơ
khác.



5/ Ch  đ  b o v  màn hình (Screen Saver)ế ộ ả ệ5/ Ch  đ  b o v  màn hình (Screen Saver)ế ộ ả ệ
 Kích ph i t i kho ng ả ạ ả

tr ng Dekstop. Ch n ố ọ
Properties.

 Ch n th  Screen ọ ẻ
Saver. Ch n m t ọ ộ
ki u trong danh sách.ể

 Thi t l p th i gian đ i ế ậ ờ ợ
trong m c ụ Wait

 Settings: thay đ i ổ
theo ý ng i s  ườ ử
d ng.ụ

 Preview: xem tr c.ướ



6/ Thay đ i giao di n Windowsổ ệ6/ Thay đ i giao di n Windowsổ ệ
 Kích ph i chu t t i ả ộ ạ

kho ng tr ng trên ả ố
Desktop. Ch n ọ
Properties. Ch n ọ
th  ẻ Appearance.

 Ch n m t m u ọ ộ ẫ
trong Scheme.

 Tr  v  ki u m c ả ề ể ặ
đ nh: Ch n m u ị ọ ẫ
Windows 
Standard.



7/ Thi t l p đ  phân gi iế ậ ộ ả7/ Thi t l p đ  phân gi iế ậ ộ ả
 Trong Display 

Properties. Ch n th  ọ ẻ
Settings.

 Ch n s  l ng màu ọ ố ượ
trong m c Colors. ụ
M c đ nh là ặ ị High 
color 24bit.

 Ch n đ  phân gi i ọ ộ ả
trong m c ụ Screen 
Area. Chu n là 800 X ẩ
600.

 Ch n đ  phân gi i l n ọ ộ ả ớ
thì ch  hi n th  s  nh  ữ ể ị ẽ ỏ
và ng c l i.ượ ạ



8/ S p x p các bi u t ng trên Desktopắ ế ể ượ8/ S p x p các bi u t ng trên Desktopắ ế ể ượ
 Kích ph i t i v  trí tr ng trên Desktop.ả ạ ị ố
 Ch n Arrange Icons.ọ

 Auto Range: S p x p t  đ ng.ắ ế ự ộ
 By Name: S p theo tên.ắ
 By Type: Theo ki u t p tin, th  m c.ể ậ ư ụ
 By Size: Theo dung l ng c a bi u t ng.ượ ủ ể ượ
 By Date: S p theo ngày t o l p.ắ ạ ậ



BÀI 4BÀI 4

QU N LÝ T P TIN Ả ỆQU N LÝ T P TIN Ả Ệ
VÀ TH  M C V I Ư Ụ ỚVÀ TH  M C V I Ư Ụ Ớ
MY COMPUTERMY COMPUTER



I/ Kh i đ ngở ộI/ Kh i đ ngở ộ
 Nh n đúp vào bi u t ng ấ ể ượ My Computer trên màn 
hình Desktop.



II/ Hi n th  thanh công cể ị ụII/ Hi n th  thanh công cể ị ụ
 Windows Explorer c n 2 thanh công c :ầ ụ

 Standard Buttons: Ch a các l nh t  menu giúp thao tác ứ ệ ừ
nhanh v i t p tin và th  m c.ớ ậ ư ụ

 Address bar: hi n th  đ ng d n c a t p tin, th  m c.ể ị ườ ẫ ủ ậ ư ụ
 Vào menu Views – Toolbars. Đánh d u vào các ấ

thanh công c  c n hi n th .ụ ầ ể ị



III/ Làm vi c v i t p tin & th  m cệ ớ ệ ư ụIII/ Làm vi c v i t p tin & th  m cệ ớ ệ ư ụ
1/ T o m i t p tin (NEW):ạ ớ ậ
 M c đích: ụ Ch a n i dung văn b n, hình h a, video…ứ ộ ả ọ
 Th c hi n:ự ệ

 Ch n n i l u t p ọ ơ ư ậ
tin (đĩa, th  m c).ư ụ

 Kích ph i chu t ả ộ
t i v  trí tr ng.ạ ị ố

 Ch n New – Kích ọ
ch n 1 ki u t p tin ọ ể ậ
trong danh sách.

 Đ t tên cho t p tin ặ ậ
(không đ c trùng ượ
tên v i t p tin đã có).ớ ậ



2/ Nh p n i dung cho t p tinậ ộ ậ2/ Nh p n i dung cho t p tinậ ộ ậ
 Nh n đúp vào tên t p tin.ấ ậ
 Nh p n i dung b t kỳ.ậ ộ ấ
 Đóng c a s  c a t p tin l i.ử ổ ủ ậ ạ
 Ch n Yes đ  l u n i dung t p tin l i.ọ ể ư ộ ậ ạ



3/ T o m i 1 th  m c (New)ạ ớ ư ụ3/ T o m i 1 th  m c (New)ạ ớ ư ụ
 Ch n n i đ t th  m c.ọ ơ ặ ư ụ
 Kích ph i chu t t i v  trí tr ng.ả ộ ạ ị ố
 Ch n New – Folder.ọ
 Nh p tên cho th  m c v a t o.ậ ư ụ ừ ạ



4/ T o m i 1 l i t tạ ớ ố ắ4/ T o m i 1 l i t tạ ớ ố ắ
 Cách 1:

 Truy c p vào n i ch a ng d ng.ậ ơ ứ ứ ụ
 Kích ph i chu t trên đ i t ng c n t o l i t t. ả ộ ố ượ ầ ạ ố ắ

Ch n ọ Send to – Desktop (Create Shortcut)
 Cách 2:

 Kích ph i t i v  trí tr ng trên ả ạ ị ố Desktop. Ch n ọ New – 
Shortcut. Nh n nút ấ Browse ch n đ ng d n c a ọ ườ ẫ ủ
t p tin, th  m c c n t o l i t t. Nh n ậ ư ụ ầ ạ ố ắ ấ OK. Nh n ấ
Next.

 Nh p tên cho ậ shortcut. Nh n ấ Finish.



5/ Đ i tên (Rename)ổ5/ Đ i tên (Rename)ổ
 Cách 1: Kích ph i ả

chu t trên đ i t ng ộ ố ượ
c n đ i tên. Ch n ầ ổ ọ
Rename.Nh p tên m i.ậ ớ

 Cách 2: Kích ch n đ i ọ ố
t ng. Nh n phím F2. ượ ấ
Nh p tên m i.ậ ớ



6/ Xóa (Delete)6/ Xóa (Delete)
 Cách 1: Kích ph i ả

chu t trên đ i t ng ộ ố ượ
c n xóa. Ch n Delete. ầ ọ
Nh n Yes.ấ

 Cách 2: Kích chu t ộ
ch n đ i t ng c n ọ ố ượ ầ
xóa. Nh n phím ấ
Delete. Nh n Yes.ấ

 L u ý:ư  Đ  xóa h n đ i ể ẳ ố
t ng kh i mà không ượ ỏ
cho vào trong thùng 
rác thi nh n gi  phím ấ ữ
Shift khi xóa



7/ Sao chép (Copy) và di chuy n (Move)ể7/ Sao chép (Copy) và di chuy n (Move)ể
 Sao chép (Copy):

 Kích ph i chu t trên đ i t ng c n sao chép. ả ộ ố ượ ầ
Ch n ọ Copy – t c sao chép. (ho c nh n ứ ặ ấ Ctrl + C).

 Truy c p vào th  m c - n i c n copy đ n. Kích ậ ư ụ ơ ầ ế
ph i ch n ả ọ Paste – t c dán. (ho c nh n ứ ặ ấ Ctrl + V)

 Di chuy n (Move):ể
 Kích ph i chu t trên đ i t ng c n di chuy n. ả ộ ố ượ ầ ể

Ch n ọ Cut – t c c t (ho c ứ ắ ặ Ctrl + X).
 Truy c p vào th  m c - n i c n copy đ n. Kích ậ ư ụ ơ ầ ế

ph i ch n ả ọ Paste – t c dán. (Ho c ứ ặ Ctrl + V)



BÀI T PẬBÀI T PẬ
  Trong  đĩa C:\ t o 2 th  m c tx_QuangNgai và ổ ạ ư ụ

tp_DaNang
  Trong th  m c tx_QuangNgai t o 2 th  m c con là ư ụ ạ ư ụ

DaiViet và Daotao.
  Trong th  m c DaiViet t o 2 t p tin vanban.txt và t p ư ụ ạ ệ ệ

giaymoi.txt
  Đ i tên th  m c tx_QuangNgai thành th  m c ổ ư ụ ư ụ

tp_QuangNgai
  Sao chép t t c  các th  m c trong th  m c ấ ả ư ụ ư ụ

tp_QuangNgai vào trong th  m c tp_DaNangư ụ
  Đ i tên th  m c tp_DaNang thành VietNamổ ư ụ
  Xóa th  m c VietNamư ụ



8/ Ch n các đ i t ngọ ố ượ8/ Ch n các đ i t ngọ ố ượ
 Ch n nhi u đ i ọ ề ố

t ng g n nhau:ượ ầ  
Nh n gi  Shift + phím ấ ữ
mũi tên (Ho c Kích ặ
gi  chu t và vây ữ ộ
vùng hi n th  các đ i ể ị ố
t ng c n ch nượ ầ ọ ).

 Ch n nhi u đ i ọ ề ố
t ng r i r c:ượ ờ ạ  Gi  ữ
Ctrl + kích chu t ch n ộ ọ
t ng đ i t ng c n ừ ố ượ ầ
ch n.ọ

 Ctrl + A: Ch n t t c  ọ ấ ả
các đ i t ng.ố ượ



9/ Ki u hi n thể ể ị9/ Ki u hi n thể ể ị
 Kích ph i chu t t i v  trí ả ộ ạ ị

tr ng b t kỳ trong th  m c ố ấ ư ụ
c n đ i ki u hi n th .ầ ổ ể ể ị

 Ch n View:ọ
 Large Icons: Bi u ể

t ng phóng to.ượ
 Small Icons: Bi u t ng ể ượ

thu nh .ỏ
 List: D ng danh sách ạ

li t kê.ệ
 Details: Chi ti t (Tên, ế

Ngày gi , dung l ng…)ờ ượ
 Thumbnails: Thu nh  ỏ

n i dung bên trong – ộ
dành đ  xem tr c hình ể ướ

nh.ả



10/ S  d ng thanh công cử ụ ụ10/ S  d ng thanh công cử ụ ụ

 Back: quay v  c a s  tr c đó.ề ử ổ ướ
 Forward: ti n t i trang tr c khi quay v .ế ớ ướ ề
 Up: Lên th  m c cha.ư ụ
 Searchs: n/hi n c a s  tìm ki m.Ẩ ệ ử ổ ế
 Folders: n/hi n cây th  m c.Ẩ ệ ư ụ



11/ S  d ng thanh tr ng thái (Status Bar)ử ụ ạ11/ S  d ng thanh tr ng thái (Status Bar)ử ụ ạ
 Vào menu Views – Status Bar để hiển thị thanh 

trạng thái.
 Thanh trạng thái cho biết:

 Tổng số tập tin & thư mục có trong thư mục hiện tại 
(Object).

 Tổng dung lượng.



12/ Xem thu c tính các phân vùng  c ngộ ổ ứ12/ Xem thu c tính các phân vùng  c ngộ ổ ứ
 Kích ph i trên đĩa ch n ả ọ

Properties. Ch n th  ọ ẻ
General.

 Used space: dung l ng ượ
đĩa dùng.

 Free space: dung l ng ượ
còn tr ngố

 Capacity: T ng dung ổ
l ng đĩa.ượ

 Label: Nhãn đĩa



IV/ S  D NG WINDOWS EXPLORERỬ ỤIV/ S  D NG WINDOWS EXPLORERỬ Ụ
 Windows Explorer là m t ch ng trình ng d ng ộ ươ ứ ụ

đ c tích h p s n trên môi tr ng Windows – cho ượ ợ ẵ ườ
phép ng i s  d ng thao tác đ n các tài nguyên ườ ử ụ ế
trong h  th ng máy tính d i d ng c u trúc cây (c u ệ ố ướ ạ ấ ấ
trúc th a k ).ừ ế

 Kh i đ ng Windows Explorer:ở ộ
 Cách 1: Nháy chu t ph i lên bi u t ng My Computer, ộ ả ể ượ

ch n Exploreọ
 Cách 2: Vào My Computer, sau đó kích lên nút Folders 

trên thanh công cụ
 Cách 3: Nh n t  h p phím Windows+Eấ ổ ợ



IV/ WINDOWS EXPLORER (tt)IV/ WINDOWS EXPLORER (tt)
 S  d ng kéo & th  (Drag & Drop):ử ụ ả

 Dùng chu t kéo 1 th  m c, t p tin vào th  m c khác đ  ộ ư ụ ậ ư ụ ể
th c hi n l nh di chuy n.ự ệ ệ ể

 K t h p phím Ctrl + Kéo th  đ  th c hi n l nh sao chép.ế ợ ả ể ự ệ ệ
 Kéo 1 đ i t ng qua  đĩa khác tên là th c hi n l nh sao ố ượ ổ ự ệ ệ

chép.
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S  D NG THÙNG RÁC – Ử ỤS  D NG THÙNG RÁC – Ử Ụ
RECYCLE BINRECYCLE BIN



RECYCLE BINRECYCLE BIN
1/ Khái ni m:ệ  Recycle 

Bin (thùng tái ch ) ế
dùng đ  ch a các ể ứ
t p tin th  m c b  ậ ư ụ ị
xóa.

2/ Khôi ph c các t p ụ ậ
tin, th  m c b  ư ụ ị
xóa:

 Nh n đúp vào bi u t ng ấ ể ượ
Recycle Bin trên màn hình 
n n ề Desktop.

 Kích ph i chu t trên đ i ả ộ ố
t ng c n khôi ph c.ượ ầ ụ

 Ch n ọ Restore.



 Đ  xóa m t t p tin, th  m c kh i thùng rác. Kích ể ộ ậ ư ụ ỏ
ph i chu t ch n Delete. Nh n Yes.ả ộ ọ ấ

 Đ  xóa t t c  trong thùng rác. Vào File, ch n Empty ể ấ ả ọ
Recycle Bin.

3/ Đ  rácổ3/ Đ  rácổ



4/ Tăt hôp thoai xac nhân khi xoa tâp tin, th  muć ̣ ̣ ́ ̣ ́ ̣ ư ̣4/ Tăt hôp thoai xac nhân khi xoa tâp tin, th  muć ̣ ̣ ́ ̣ ́ ̣ ư ̣

 Kích ph i chu t trên ả ộ
Recyle Bin.

Ch n ọ Properties.

B  ch n m c: ỏ ọ ụ Display 
delete confirmation 
dialog.



5/ Không s  d ng thùng rácử ụ5/ Không s  d ng thùng rácử ụ
 Kích ph i chu t trên ả ộ

thùng rác.

 Ch n Properties.ọ

 Đánh d u m c:ấ ụ  Do 
not move files to the 
Recycle Bin.
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CONTROL PANEL- CONTROL PANEL- 
B NG ĐI U KHI N MÁY Ả Ề ỂB NG ĐI U KHI N MÁY Ả Ề Ể

TÍNHTÍNH



I/ Gi i thi uớ ệI/ Gi i thi uớ ệ
 Control Panel ch a các công c  giúp ng i s  d ng ứ ụ ườ ử ụ

thi t l p- cá nhân hóa PC theo ý mình.ế ậ

 M i thành ph n g i là ỗ ầ ọ Applet



II/ Kh i đ ng Control Panelở ộII/ Kh i đ ng Control Panelở ộ
 Start Menu – Settings – Control Panel (Ho c phím Windows – ặ

S – C)

 Nh p ậ Control vào c a s  Run (Windows + R). Nh n Enter.ử ổ ấ

 My Computer. Nh n đúp Control Panel.ấ



1/ Xem thông tin h  th ngệ ố1/ Xem thông tin h  th ngệ ố
 Nháy đúp vào bi u t ng ể ượ

System trong c a s  ử ổ
Control Panel (Ho c có ặ
th  nháy ph i chu t vào ể ả ộ
My Computer, ch n ọ
Properties)

 Ch n th  General:ọ ẻ

 System: H  đi u hành ệ ề
đang s  d ngử ụ

 Computer: CPU lo i gì, ạ
dung l ng RAMượ



2/ Thi t l p màn hình n n Desktopế ậ ề2/ Thi t l p màn hình n n Desktopế ậ ề
 Ch y Displayạ

 Có th  kích ph i ể ả
chu t trên ộ
Desktop, ch n ọ
Properties



3/ Thi t l p ngày/gi  h  th ngế ậ ờ ệ ố3/ Thi t l p ngày/gi  h  th ngế ậ ờ ệ ố  
 Ch y ạ Date/Time
(Ho c có th  nháy ặ ể

đúp chu t vào ộ
đ ng h  d i ồ ồ ướ
khay h  th ng)ệ ố

 Có th  thay đ i ể ổ
ngay, gi , múi gi  ờ ờ
phù h p v i hi n ợ ớ ệ
t i.ạ



4/ Thi t l p chu t (Mouse)ế ậ ộ4/ Thi t l p chu t (Mouse)ế ậ ộ
 Ch y Mouseạ

 Th  Buttonsẻ : Thi t l p ế ậ
các nút nh nấ

 Th  Pointerẻ : Thi t l p ế ậ
các ki u con tr  chu tể ỏ ộ

 Th  Motionẻ : Thi t l p ế ậ
t c đ , hình d ng di ố ộ ạ
chuy n c a chu t.ể ủ ộ



4.1/ Thi t l p nút nh nế ậ ấ4.1/ Thi t l p nút nh nế ậ ấ
 Button Configuration: 

Thay đ i tay s  d ng chu t.ổ ử ụ ộ
 File or Folders: Thay đ i ổ

cách m  t p tin, th  m c ở ệ ư ụ
b ng chu t.ằ ộ

 Double click Speed: Thay 
đ i t c đ  nháy đúp chu t.ổ ố ộ ộ



4.2/ Thi t l p ki u con trế ậ ể ỏ4.2/ Thi t l p ki u con trế ậ ể ỏ
 Ch n m t m u có s n ọ ộ ẫ ẵ

trong m c ụ Scheme.
 Kích ch n t ng ki u ọ ừ ể

con tr . Nh n nút ỏ ấ
Browse đ  tìm nh ng ể ữ
hình d ng con tr  khác.ạ ỏ

 Dùng nút Use Default 
đ  tr  v  con tr  m c ể ở ề ỏ ặ
đ nh.ị



4.3/ Thi t l p s  di chuy nế ậ ự ể4.3/ Thi t l p s  di chuy nế ậ ự ể
 Nên dùng ki u m c ể ặ

đ nh:ị
 Speed: Kéo v  v  ề ị

trí chính gi a.ữ
 Acceleration: 

Ch n Lowọ
 Snap to Default: 

B  ch nỏ ọ



5/ Qu n lý Font chả ữ5/ Qu n lý Font chả ữ
 Ch y Fontsạ
 C a s  Font qu n lý t t c  các font đang có trong máy.ử ổ ả ấ ả
 Cài thêm Font m i:ớ

 File-Install New Font.
 Ch n  đĩa và th  m c có ch a font ngu n.ọ ổ ư ụ ứ ồ
 Ch n font c n cài trong danh sách.ọ ầ



6/ Thi t l p cho t p tin & th  m cế ậ ậ ư ụ6/ Thi t l p cho t p tin & th  m cế ậ ậ ư ụ
 Chạy Folder 

Options.
 Hoặc menu 

Tools – Folders 
Options.



6.1/ Thi t l p chung (th  General)ế ậ ẻ6.1/ Thi t l p chung (th  General)ế ậ ẻ
 Active Desktop: Ki u hi n th  c a Desktop. Ch n ể ể ị ủ ọ

Use Windows classic Desktop.
 Web view: Quy cách hi n th  c a s  th  m c. Ch n ể ị ử ổ ư ụ ọ

Enable Web conntent in folders.
 Browse Folders: Cách hi n th  c a s  khi truy c p ể ị ử ổ ậ

th  m c. Ch n ư ụ ọ Open each folder in the same 
window.

 Click items and follows: Cách m  t p tin và th  ở ậ ư
m c. Ch n ụ ọ Double - click



6.2/ Cách hi n th  t p tin & th  m c (th  ể ị ậ ư ụ ẻ6.2/ Cách hi n th  t p tin & th  m c (th  ể ị ậ ư ụ ẻ
View)View) Display full path in the 

address bar: hi n th  đ y đ  ể ị ầ ủ
đ ng d n trên thanh đ a ch .ườ ẫ ị ỉ

 Do not show hidden files 
and folders: Không hi n th  ể ị
các t p tin và th  m c b  n.ậ ư ụ ị ẩ

 Show all hidden files and 
folders: Hi n th  t t c  các ể ị ấ ả
t p tin và th  m c b  n.ậ ư ụ ị ẩ

 Hide file extensions for 
known file types: n ph n Ẩ ầ
m  r ng cùa các ki u t p tin ở ộ ể ậ
đã đ c nh n d ng.ượ ậ ạ

 Hide protected operating 
system files: n nh ng t p Ẩ ữ ậ
tin h  th ng c a HĐH.ệ ố ủ



7/ Thi t l p theo vùng mi nế ậ ề7/ Thi t l p theo vùng mi nế ậ ề
 Ch y Regional Options.ạ
 Bao g m các thi t l p v  ngôn ng  s  d ng, ồ ế ậ ề ữ ử ụ

h  s , h  ti n t , h  ngày tháng, h  th i gian.ệ ố ệ ề ệ ệ ệ ờ



7.1/ Thay đ i h  sổ ệ ố7.1/ Thay đ i h  sổ ệ ố
 M c đích: ụ Thay đ i t  h  ổ ừ ệ

s  c a ố ủ USA thành h  s  ệ ố
c a ủ VN.

 Th c hi n:ự ệ
 Ch n th  ọ ẻ Numbers.
 Decimal sysmbol - 

D u phân cách ph n ấ ầ
nguyên và ph n th p ầ ậ
phân: Nh p d u ph y ậ ấ ẩ
(,).

 Digit grouping 
symbol - D u nhóm ấ
s : Nh p d u ch m (.)ố ậ ấ ấ



7.2/ Thay đ i h  ti n tổ ệ ề ệ7.2/ Thay đ i h  ti n tổ ệ ề ệ
 Currency symbol: 

Nh p ký t  đ i di n ậ ự ạ ệ
ti n t . Ví d  VNĐ.ề ệ ụ

 Positive currency 
format: Ch n ki u hi n ọ ể ể
th  c a ký t  ti n t  ị ủ ự ề ệ
trong m t giá tr  ki u ộ ị ể
ti n t .ề ệ



7.3/ Thi t l p th i gianế ậ ờ7.3/ Thi t l p th i gianế ậ ờ
 Ch n m t đ nh d ng ọ ộ ị ạ

th i gian trong ờ Time 
Format.

 Xem k t qu   m c ế ả ở ụ
Time Sample.



7.4/ Thi t l p ki u ngày thángế ậ ể7.4/ Thi t l p ki u ngày thángế ậ ể
 Nh p ậ dd/mm/yyyy 

bi u th  cho ki u ể ị ể
ngày VN vào ô Short 
Date Format.
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S  D NG CÁC TI N Ử Ụ ỆS  D NG CÁC TI N Ử Ụ Ệ
ÍCH C A WINDOWSỦÍCH C A WINDOWSỦ



1/ Tìm ki mế1/ Tìm ki mế
 M c đích:ụ  Đ  tìm m t t p tin, th  m c có t n t i hay ể ộ ậ ư ụ ồ ạ

không trong máy.
 Th c hi n:ự ệ

 Start – Search – For Files or Folders. (ho c phím ặ
Windows + F).

 Nh n F3 đ  tìm trong th  m c hi n t i.ấ ể ư ụ ệ ạ



1.1/ Tìm ki m đ n gi nế ơ ả1.1/ Tìm ki m đ n gi nế ơ ả
 Nh p tên t p tin, th  m c c n tìm vào m c ậ ậ ư ụ ầ ụ Search for file 

or folders named.
 Ch n n i tìm trong m c ọ ơ ụ Look in (nên ch n ọ My Computer)
 Kích chu t vào nút ộ Search Now ho c nh n ặ ấ Enter.



1.2/ S  d ng ký t  thay thử ụ ự ế1.2/ S  d ng ký t  thay thử ụ ự ế
 Dùng d u ấ ? đ  đ i di n cho 1 ký t  không xác đ nh đ c.ể ạ ệ ự ị ượ
 Dùng d uấ  * đ  đ i di n cho 1 ho c nhi u ký t .ể ạ ệ ặ ề ự
 Ví d :ụ  Nh pậ  *.doc đ  tìm t t c  các t p tin văn b n word.ể ấ ả ậ ả



2/ S  d ng MS Paintử ụ2/ S  d ng MS Paintử ụ
 Gõ mspaint vào c a s  ử ổ RUN.
 Vào File – Save. Ch n n i l u hình và đ t tên cho hình. ọ ơ ư ặ

Nh n Save.ấ

Ch n v  trí l uọ ị ư



Module 3Module 3   

CÔNG NGH  INTERNETỆCÔNG NGH  INTERNETỆ



I/ Khái ni m m ng máy tínhệ ạI/ Khái ni m m ng máy tínhệ ạ
 M ng máy tính là m t t p h p các máy tính đ c n i ạ ộ ậ ợ ượ ố

v i nhau b i môi tr ng truy n (đ ng truy n)  theo ớ ở ườ ề ườ ề
m t c u trúc nào đó và thông qua đó các máy tính ộ ấ
trao đ i thông tin qua l i cho nhau.ổ ạ

 Môi tr ng truy n là h  th ng các thi t b  truy n d n có ườ ề ệ ố ế ị ề ẫ
dây hay không dây dùng đ  chuy n các tín hi u đi n t  t  ể ể ệ ệ ử ừ
máy tính này đ n máy tính khác.ế



II/ Đ nh nghĩa m ng LAN, WANị ạII/ Đ nh nghĩa m ng LAN, WANị ạ
 M ng ạ LAN (Local Area Network) là m ng n i b , k t ạ ộ ộ ế

n i các máy tính c a m t c  quan, t  ch c trong ố ủ ộ ơ ổ ứ
ph m vi nh , bán kính vài trăm mét.ạ ỏ



II/ Đ nh nghĩa m ng LAN, WAN (tt)ị ạII/ Đ nh nghĩa m ng LAN, WAN (tt)ị ạ
 M ng ạ WAN (Wide Area Network) là m ng di n r ng, ạ ệ ộ

k t n i các m ng LAN  xa nhau đ  có m t m ng ế ố ạ ở ể ộ ạ
duy nh t. Thông th ng k t n i này đ c th c hi n ấ ườ ế ố ượ ự ệ
thông qua m ng vi n thông hay v  tinh.ạ ễ ệ



III/ Internet là gì?III/ Internet là gì?
 Internet là liên m ng máy tính toàn c u. Là s  k t ạ ầ ự ế

h p các m ng LAN, WAN trên toàn th  gi i.ợ ạ ế ớ
 Tháng 12/1997, Vi t Nam k t n i Internet.ệ ế ố

U N I V E R S I T YU N I V E R S I T Y



IV/ M t s  đ a ch  Webộ ố ị ỉIV/ M t s  đ a ch  Webộ ố ị ỉ
1/ Tin t c:ứ
 C ng Internet VN: ổ home.vnn.vn
 Báo tu i tr : ổ ẻ www.tuoitre.com.vn
 Báo TN: www.thanhnien.com.vn
 Báo CAND: www.cand.com.vn
 Báo CA TPHCM: 

www.baocongantphcm.com.vn
 Báo Lao đ ng: ộ www.laodong.com.vn
 Báo Nhân dân: www.nhandan.com.vn
 Tin nhanh: www.vnexpress.net

http://home.vnn.vn/
http://www.tuoitre.com.vn/
http://www.thanhnien.com.vn/
http://www.cand.com.vn/
http://www.baocongantphcm.com.vn/
http://www.laodong.com.vn/
http://www.nhandan.com.vn/
http://www.vnexpress.net/


IV/ M t s  đ a ch  Web (tt)ộ ố ị ỉIV/ M t s  đ a ch  Web (tt)ộ ố ị ỉ
2/ Gi i trí:ả
 Nh c vi t: ạ ệ nhacviet.vietnamnet.vn
 VN Th  quán: ư vnthuquan.net
 Nh c s : ạ ố www.nhacso.net
 Nh c QN: ạ www.thienan.org
 Ng i m u: ườ ẫ www.mm52.com, 

www.24h.com.vn, www.ngoisao.net

http://nhacviet.vietnamnet.vn/
http://vnthuquan.net/
http://www.nhacso.net/
http://www.thienan.org/
http://www.mm52.com/
http://www.24h.com.vn/
http://www.ngoisao.net/


IV/ M t s  đ a ch  Web (tt)ộ ố ị ỉIV/ M t s  đ a ch  Web (tt)ộ ố ị ỉ
3/ Tìm ki m:ế
 Google: www.google.com.vn

 Vinaseek: www.vinaseek.com

 Panvietnam: www.panvn.com

http://www.google.com.vn/
http://www.vinaseek.com/
http://www.panvietnam.com/


IV/ M t s  đ a ch  Web (tt)ộ ố ị ỉIV/ M t s  đ a ch  Web (tt)ộ ố ị ỉ
4/ Tin h c:ọ
 Tu n báo Echip: ầ www.echip.com.vn

 Báo PC World: www.pcworld.com.vn

 Di n đàn Mã ngu n: ễ ồ www.manguon.com

 Báo Tin h c & Nhà tr ng: ọ ườ www.thnt.com.vn

 Qu n tr  m ng: ả ị ạ www.quantrimang.com

http://www.echip.com.vn/
http://www.pcworld.com.vn/
http://www.manguon.com/
http://www.thnt.com.vn/
http://www.quantrimang.com/


V/ V/ Mô hình khách hàng/ng i ph c vườ ụ ụMô hình khách hàng/ng i ph c vườ ụ ụ
 Mô hình khách hàng/ng i ph c v :ườ ụ ụ  H  ệ

th ng Web đ c xây d ng theo mô hình ố ượ ự
khách hàng/ng i ph c v  (ti ng Anh g i là ườ ụ ụ ế ọ
Client/Server)

CLIENT (Khách 
hàng)

SERVER 
(Ng i ph c ườ ụ

v )ụ
 Ph i có t n t i ả ồ ạ các đi m ph c v  Webể ụ ụ , g i là ọ
Web Server. Thì chúng ta m i có đ c nh ng ớ ượ ữ
trang Web.



VI/ Qui trình k t n i và các d ch v  trên Internetế ố ị ụVI/ Qui trình k t n i và các d ch v  trên Internetế ố ị ụ

 Qui trình k t n i Internet:ế ố
PC – MODEM – PHONE LINE - ISP - INTERNET

 Internet ho t đ ng theo mô hình ạ ộ Client/Server 
(khách/ph c v ) và cung c p r t nhi u d ch ụ ụ ấ ấ ề ị
v  h u ích.ụ ữ

 www (World Wide Web): d ch v  trang tin toàn ị ụ
c uầ ..

 E-mail (Electronic Mail): d ch v  th  đi n tị ụ ư ệ ử..
 FTP (File Transfer Protocol): d ch v  truy n d  li u ị ụ ề ữ ệ

trên Internet.



VII/ Phân bi t Internet, Intranet, ExtranetệVII/ Phân bi t Internet, Intranet, Extranetệ

 M ng LAN có tri n khai các d ch v  gi ng ạ ể ị ụ ố
Internet nh  t  đi n t , trang tin n i b  gi ng ư ư ệ ử ộ ộ ố
các d ch v  c a Internet mà không có k t n i ị ụ ủ ế ố
v i bên ngoài g i là ớ ọ Intranet.

 M ng LAN có tri n khai các d ch v  gi ng ạ ể ị ụ ố
Internet và k t n i v i Internet g i là ế ố ớ ọ
Extranet.



VIII/ S  d ng trình duy t Web ử ụ ệVIII/ S  d ng trình duy t Web ử ụ ệ Internet ExplorerInternet Explorer (IE) (IE)

 Thanh công c  (Standard Buttons): ụ Cho phép th c ự
hi n nhanh các l nh thay vì ph i th c hi n t  Menu.ệ ệ ả ự ệ ừ

 Thanh đ a ch  (Address Bar):ị ỉ  Mu n truy c p trang ố ậ
Web nào thì gõ đ a ch  c a trang đó vào thanh đ a ch  ị ỉ ủ ị ỉ
và nh n Enter.ấ



VIII/ S  d ng trình duy t Web ử ụ ệVIII/ S  d ng trình duy t Web ử ụ ệ Internet ExplorerInternet Explorer (IE) (IE)

 M t s  ch c năng trên thanh công c :ộ ố ứ ụ
 Nút Back : Tr  v  trang tr c trang ở ề ướ

hi n t i.ệ ạ
 Nút Forward : Ti n t i trang tr c khi ế ớ ướ

quay v .ề
 Nút Stop : D ng t i n i dung trang hi n t i.ừ ả ộ ệ ạ
 Nút Refresh  : Nút làm t i n i dung, t i l i n i ươ ộ ả ạ ộ

dung trang web đang xem.



IX/ Nh ng khái ni m c  b n trên Internetữ ệ ơ ảIX/ Nh ng khái ni m c  b n trên Internetữ ệ ơ ả
 Trình duy t web (Browser): ệ

 Đ  s  d ng d ch v  www (trang tin toàn c u) máy b n ể ử ụ ị ụ ầ ạ
c n có ít nh t m t trình duy t web nh  Internet Explorer ầ ấ ộ ệ ư
(IE), Mozilla Firefox, Netscape Navigator, Opera,…

 Trình duy t web là m t ch ng trình t i các trang tin ệ ộ ươ ả
(web) v  máy c a ng i s  d ng t  máy ch  ph c v  ề ủ ườ ử ụ ừ ủ ụ ụ
web.



IX/ Nh ng khái ni m c  b n trên Internet (tt)ữ ệ ơ ảIX/ Nh ng khái ni m c  b n trên Internet (tt)ữ ệ ơ ả
 Domain (Tên mi n):ề

 Tên miền là tên của một máy chủ phục vụ web trên mạng.
 Tên miền do tổ chức Internet quốc tế quản lý.
 Tên miền là tên duy nhất trên thế giới.
 Cấu trúc tên miền gồm: WWW.<TÊN>.<MỞ RỘNG>WWW.<TÊN>.<MỞ RỘNG>
 Ví dụ: Ví dụ: www.tuoitre.com.vnwww.tuoitre.com.vn
 Một tên miền có thể có một hoặc nhiều phần mở rộng. Tên 

phần mở rộng cho biết lĩnh vực hoạt động hoặc quốc gia 
nơi nó đăng ký.
 Quốc gia: .vn của VN, .uk của Anh, .us của Mỹ, .ca của Canada.
 Lĩnh vực như: .net: liên mạng, .com là thương mại, .edu là giáo dục, 

.gov là chính phủ, .org là tổ chức.
 Tên miền là một hình thức thể hiểu ngắn gọn của địa chỉ 

IP giúp người sử dụng truy cập một máy chủ phục vụ web 
không cần nhớ địa chỉ IP của máy đó.

http://www.tuoitre.com.vn/


IX/ Nh ng khái ni m c  b n trên Internet (tt)ữ ệ ơ ảIX/ Nh ng khái ni m c  b n trên Internet (tt)ữ ệ ơ ả
 HTTP: Hyper Text Transfer Protocol – Ph ng th c ươ ứ

truy n siêu văn b n trên Internet cho phép truy n n i ề ả ề ộ
dung nh ng trang tin toàn c u (WWW) t  máy ph c ữ ầ ừ ụ
v  web v  máy ng i s  d ng.ụ ề ườ ử ụ

 Hyperlink-Siêu liên k t, là m t tính ch t quan tr ng ế ộ ấ ọ
c a trang Web. T i v  trí nào đó c a trang Web mà ủ ạ ị ủ
con tr  chu t chuy n sang d ng ỏ ộ ể ạ hình bàn tay tr     ỏ thì 

 v  đó có m t siêu liên k t (Khi kích chu t s  liên k t ở ị ộ ế ộ ẽ ế
(m ) đ n m t trang web m i).ở ế ộ ớ



IX/ Nh ng khái ni m c  b n trên Internet (tt)ữ ệ ơ ảIX/ Nh ng khái ni m c  b n trên Internet (tt)ữ ệ ơ ả
 ISP: Nhà cung c p d ch v  Internet (Internet Service ấ ị ụ

Providers): N i b n đăng ký đ  gia nh p Internet và ơ ạ ể ậ
s  d ng các d ch v  mà ISP cung c p nh  Web, ử ụ ị ụ ấ ư
mail.

 M t s  ISP  Vi t Nam: Viettel, FPT, Saigonnet, ộ ố ở ệ
VDC,...



X/ Tìm ki m thông tin trên InternetếX/ Tìm ki m thông tin trên Internetế
 Tìm ki m qua các trang Web đ ng g i là máy tìm ế ộ ọ

ki m (ế Search Engine). Là m t h  th ng cho phép ộ ệ ố
tìm ki m các thông tin trên Internet theo yêu c u c a ế ầ ủ
ng i s  d ng.ườ ử ụ

 Ví d  nh  trang Web: ụ ư www.google.com là m t ộ
trang Web h  tr  tìm ki m c c m nh, và đ c s  ỗ ợ ế ự ạ ượ ử
d ng ph  bi n trên Internet hi n nay.ụ ổ ế ệ



XI/ Phân bi t web tĩnh, web đ ngệ ộXI/ Phân bi t web tĩnh, web đ ngệ ộ
 Web tĩnh có n i dung đ c chu n b  s n, không thay ộ ượ ẩ ị ẵ

đ i theo nhu c u c a ng i s  d ng. Ví d : nh ng ổ ầ ủ ườ ử ụ ụ ữ
trang gi i thi u, CSDL lu t,…ớ ệ ậ

 Web đ ng có n i dung thay đ i theo nhu c u ng i ộ ộ ổ ầ ườ
s  d ng. Ví d  các trang tin t c, tìm ki m, bán hàng ử ụ ụ ứ ế
trên m ng,…ạ



Module 4Module 4   

TRÌNH SO N TH O VĂN B NẠ Ả ẢTRÌNH SO N TH O VĂN B NẠ Ả Ả
MICROSOFT WORDMICROSOFT WORD



BÀI 1BÀI 1

T O VÀ L U TR  Ạ Ư ỮT O VÀ L U TR  Ạ Ư Ữ
M T TÀI LI U M IỘ Ệ ỚM T TÀI LI U M IỘ Ệ Ớ



I/ Gi i thi u v  Wordớ ệ ềI/ Gi i thi u v  Wordớ ệ ề
 Là 1 trong 6 ph n m m c a b  ầ ề ủ ộ Microsoft Office c a ủ

hãng Microsoft (M ) sáng l pỹ ậ .
 Là ph n m m chuyên dùng x  lý văn b n trong công ầ ề ử ả

tác văn phòng.
 T p tin thi hành c a Word có tên: winword.exeệ ủ

(N m tằ rong đ ng d n: ườ ẫ C:\Program Files\Microsoft 
Office\Office\Winword. exe)

 T p tin mà Word sinh ra có ph n m  r ng là: *.ệ ầ ở ộ doc



II/ Màn hình làm vi c c a Wordệ ủII/ Màn hình làm vi c c a Wordệ ủ



III/ T o t p tin văn b n m iạ ệ ả ớIII/ T o t p tin văn b n m iạ ệ ả ớ
 Khi kh i đ ng, MS-Word t  đ ng t o ra s n m t tài ở ộ ự ộ ạ ẵ ộ

li u tr ng v i tên làệ ắ ớ  Document1.
 Ho c nh n nút ặ ấ New Blank Document trên thanh 

công c .ụ
 Ho c nh n t  h p phím ặ ấ ổ ợ Ctrl+N.
 Ho c vào Menu ặ File, ch n ọ New.

New Blank Document



IV/ M  t p tin văn b n đã cóở ệ ảIV/ M  t p tin văn b n đã cóở ệ ả
 Vào Menu File, ch n ọ Open (Ctrl+O).

Kích ch n ọ
m t t p ộ ậ
tin mu n ố

mở

Ch n Open đ  mọ ể ở

 Chú ý:Chú ý: Có th  ch n nhi u t p tin đ  m  cùng m t lúc.ể ọ ề ậ ể ở ộ

Ch n n i có ch a tài ọ ơ ứ
li u c n mệ ầ ở



V/ L u văn b nư ảV/ L u văn b nư ả
 Vào Menu File, ch n ọ Save ho c ặ Save As…

Có th  t o ra th  ể ạ ư
m c m i b ng ụ ớ ằ

cách kích vào đây

Ch n v  trí l u ọ ị ư
(  đĩa, th  m c Ổ ư ụ

nào)

Đ t tên cho t p ặ ậ
tin 

Xác nh n l u ậ ư



VI/ Phóng to, thu nh  khung nhìn văn b nỏ ảVI/ Phóng to, thu nh  khung nhìn văn b nỏ ả
 M c đ nh khung nhìn tài li u đ c đ t t  l  100%. ặ ị ệ ượ ặ ỉ ệ

Ng i dùng có th  tăng ho c gi m t  l  khung nhìn ườ ể ặ ả ỉ ệ
b ng công cằ ụ Zoom.

 Thay đ i khung nhìn không làm thay đ i kích th c kí ổ ổ ướ
t  trên tài li u khi in.ự ệ

 Cách th c hi n:ự ệ
 Cách 1: Kích chu t vào menu ộ View, ch nọ  Zoom.
 Cách 2: Kích chu t vào h p ộ ộ Zoom trên thanh công 

c .ụ



BÀI 2BÀI 2

CÁC THAO TÁC SO N TH O Ạ ẢCÁC THAO TÁC SO N TH O Ạ Ả
VĂN B NẢVĂN B NẢ



I/ V n đ  gõ ti ng Vi t trong văn b nấ ề ế ệ ảI/ V n đ  gõ ti ng Vi t trong văn b nấ ề ế ệ ả
 Để gõ đ cượ  ti ngế  Vi tệ  trong trình so nạ  th oả  văn b n ả
Word và cũng nh  h u h t t t c  các ph n m m ch y ư ầ ế ấ ả ầ ề ạ
trên môi tr ng Windows ườ ta ph iả  cài đ tặ  vào máy tính 
m tộ  chương trình ph nầ  m mề  hỗ trợ gõ ti ng Vi t.ế ệ
 Có r t nhi u ph n m m h  tr  gõ ti ng Vi t khác ấ ề ầ ề ỗ ợ ế ệ
nhau. Th ng dùng nh t là 2 ph n m m: ườ ấ ầ ề VietKey và 
UniKey.
 Trong t t c  các b  gõ ti ng Vi t thì ấ ả ộ ế ệ b ng mãả  và Font 
chữ đ u ph i phù h p v i nhau.ề ả ợ ớ



1/ B ng mã và font ch  ti ng Vi tả ữ ế ệ1/ B ng mã và font ch  ti ng Vi tả ữ ế ệ
B ng mãả Font

TCVN3 (Là b ng mã tiêu ả
chu n qu c gia)ẩ ố

-Font ABC
-Tên các Font b t đ u b ng d u ắ ầ ằ ấ

ch m và 2 ch  Vnấ ữ  
-vd: .Vntime, .VnArial,...

VNI (do Vietnam 
International phát tri n)ể

-Font VNI
-Tên các Font b t đ u b ng ch  VNIắ ầ ằ ữ . 
-vd: VNI-Times)

B ng mã ả Unicode. Đây 
là b ng mã theo tiêu ả
chu n qu c t  và đ c ẩ ố ế ượ
khuy n cáo nên dùng ế
trong m i ph n m m.ọ ầ ề

-Các Font có s n trong m i máy tính ẵ ọ
cài HĐH Windows

-Vd: Times New Roman, Arial, 
Tahoma, Verdana,...



2/ Ki u gõ ti ng Vi tể ế ệ2/ Ki u gõ ti ng Vi tể ế ệ
 Có 2 ki u gõ ph  bi n là ể ổ ế Telex và VNI.

f
s
r
x
j
aa
aw
oo
ow
uw
ee
dd

= huy nề
= s cắ
= h iỏ
= ngã 
= n ngặ
= â
= ă
= ô
= ơ
= ư
=ê
= đ

s  1ố
s  2ố
s  3ố
s  4ố
s  5ố
s  6ố
s  7ố
s  8ố
s  9ố

= d u s cấ ắ
= d u huy n ấ ề
= d u h i ấ ỏ
= d u ngã ấ
= d u n ng ấ ặ
= d u mũ (â, ê)ấ
= d u râu ( , ấ ơ

)ư
= d u trăng (ă)ấ
= d u ngang (đ)ấ
 

 Gõ ti ng vi t theo ki uế ệ ể  Telex:  Gõ ti ng vi t theo ki uế ệ ể  VNI:



II/ Các phím di chuy n con tr  văn b nể ỏ ảII/ Các phím di chuy n con tr  văn b nể ỏ ả
 Home: Đ a con tr  v  đ u dòng hi n t iư ỏ ề ầ ệ ạ

 End: Đ a con tr  v  cu i dòng hi n t iư ỏ ề ố ệ ạ

 Ctrl + Home: Đ a con tr  đ n v  trí đ u tiên c a tài ư ỏ ế ị ầ ủ
li uệ

 Ctrl + End: Đ a con tr  đ n v  trí cu i cùng c a tài ư ỏ ế ị ố ủ
li uệ

 Page Up: D ch chuy n con tr  lên 1 trang màn hìnhị ể ỏ

 Page Down: D ch chuy n con tr  xu ng 1 trang màn ị ể ỏ ố
hình



III/ Ch  đ  ghi chèn/ghi đèế ộIII/ Ch  đ  ghi chèn/ghi đèế ộ
 Ch  đ  ghi chèn:ế ộ  Ký t  nh p đ c chèn ngay t i v  trí ự ậ ượ ạ ị
con tr  nh p, toàn b  ký t  đ ng sau con tr  d ch chuy n ỏ ậ ộ ự ằ ỏ ị ể
sang ph i.ả

 Ch  đ  ghi đè: Ký t  nh p đ c chèn ngay t i v  trí ế ộ ự ậ ượ ạ ị
con tr  nh p, con tr  d ch chuy n sang ph i và ghi đè lên ỏ ậ ỏ ị ể ả
ký t  li n sau nó.ự ề

 Phím dùng đ  chuy n đ i qua l i gi a 2 ch  đ  ghi ể ể ổ ạ ữ ế ộ
chèn và ghi đè là phím Insert.



IV/ Ch n vùng làm vi cọ ệIV/ Ch n vùng làm vi cọ ệ
 Ch n m t câu:ọ ộ  Nh n ấ Ctrl và kích vào v  trí b t kìị ấ  
trong câu.

 Ch n m t dòng:ọ ộ  Nh pấ  vào v  trí bên tráiị  c a dòng.ủ

 Ch n m t đo n:ọ ộ ạ  Nh p đôiấ  vào kho ng tr ng bên ả ố
trái c a m t dòngủ ộ  trong đo n.ạ

 Ch n m t kh i:ọ ộ ố  Nh n ấ Shift và di chuy n chu tể ộ  t  ừ
v  trí đ u đ n cu iị ầ ế ố  đo n.ạ

 Ch n m t kh i b t kì:ọ ộ ố ấ  Nh n gi  phím ấ ữ Alt và kéo 
chu t.ộ

 Ch n toàn b  văn b n:ọ ộ ả  Ctrl+A



IV/ Ch n vùng làm vi c (tt)ọ ệIV/ Ch n vùng làm vi c (tt)ọ ệ
 Rê chu t t  đi m đ u đ n đi m cu i kh i văn b n ộ ừ ể ầ ế ể ố ố ả
c n ch n.ầ ọ

 Ho c có th  đ  con nháy đ u kh i văn b n c n ch n, ặ ể ể ầ ố ả ầ ọ
b m phím ấ Shift+Các phím mũi tên.



V/ Sao chép và di chuy n văn b nể ảV/ Sao chép và di chuy n văn b nể ả
 Ch n vùng văn b n c n sao chép hay di chuy n.ọ ả ầ ể
 Sao chép:

 Kích ch n bi u t ngọ ể ượ  hay vào Edit, ch n ọ Copy 
(Ctrl+C).

 Di chuy n con tr  văn b n đ n v  trí c n dán.ể ỏ ả ế ị ầ
 Kích ch n bi u t ng ọ ể ượ hay vào Edit, ch n ọ Paste 

(Ctrl+V).
 Di chuy n:ể

 Edit, ch n ọ Cut (Ctrl+X)
 Di chuy n con tr  văn b n đ n v  trí c n dán.ể ỏ ả ế ị ầ
 Edit, ch n ọ Paste (Ctrl+V).



VI/ S  d ng ch c năng Undo và Redoử ụ ứVI/ S  d ng ch c năng Undo và Redoử ụ ứ
 Ch c năng ứ Undo dùng đ  quay v  tr c đó m t thao tác.ể ề ướ ộ

 Kích vào bi u t ngể ượ hay nh n t  h p phím ấ ổ ợ Ctrl+Z

 Ch c năng ứ Redo ng c l i v i ch c năng Undo.ượ ạ ớ ứ
 Kích vào bi u t ngể ượ hay nh n t  h p phím ấ ổ ợ Ctrl+Y



VII/ Công c  ki m tra chính t , s a l i ng  pháp ti ng Anhụ ể ả ử ỗ ữ ếVII/ Công c  ki m tra chính t , s a l i ng  pháp ti ng Anhụ ể ả ử ỗ ữ ế

 B t / t t c ng c  ki m tra chính t  và ng  pháp:ậ ắ ộ ụ ể ả ữ  

Vào Tools - Options -> Ch n ọ Spelling & Grammar.

Bỏ dâu choń ̣  Check spelling as you type và Check 
Grammar as you type.



VIII/ Đ nh d ng trang inị ạVIII/ Đ nh d ng trang inị ạ
 Thao tác này cho phép xác đ nh chính xác v  trí c a ị ị ủ

n i dung văn b n trong t  gi y in.ộ ả ờ ấ
 Vào menu File -> Page setup.

L  trên, ề
d i, trái, ướ

ph iả

Đ nh ị
d ng l  ạ ề
cho gáy

L  cho tiêu ề
đ  đ u ề ầ
trang và 

chân trang

V  trí cho gáyị

L  c a gáy 2 trang ề ủ
liên ti p nhauế

Cho phép in 2 trang văn 
b n trên cùng m t trang inả ộ
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CÁC THAO TÁC Đ NH D NG Ị ẠCÁC THAO TÁC Đ NH D NG Ị Ạ
VĂN B NẢVĂN B NẢ



I/ Đ nh d ng ký tị ạ ựI/ Đ nh d ng ký tị ạ ự
1/ Dùng thanh công c :ụ

Font Size Bold

Italic

Underline

 Ch n kh i văn b n c n đ nh d ng.ọ ố ả ầ ị ạ

 Font: Font chữ

 Size: Kích c  ch  (ỡ ữ Ctrl+]: Tăng size; Ctrl+[: Gi m size)ả

 Bold: In đ m (ậ Ctrl+B)

 Italic: In nghiêng (Ctrl+I)

 Underline: G ch d i (ạ ướ Ctrl+U)



I/ Đ nh d ng ký t  (tt)ị ạ ựI/ Đ nh d ng ký t  (tt)ị ạ ự
2/ Dùng menu Format \ Font...

 Ngoài ra có th  ch n ể ọ
hi n th  văn b n lên màn ể ị ả
hình “sinh đ ng” b ng cách ộ ằ
ch n Tab ọ Text Effects.



II/ Áp d ng ch  to đ u đo n (Drop Cap)ụ ữ ầ ạII/ Áp d ng ch  to đ u đo n (Drop Cap)ụ ữ ầ ạ
 Đ t con tr  trong đo n văn.ặ ỏ ạ
 M  menu ở Format, ch n ọ Drop Cap



II/ Áp d ng ch  to đ u đo n (tt)ụ ữ ầ ạII/ Áp d ng ch  to đ u đo n (tt)ụ ữ ầ ạ
 Ch n ki u ch :ọ ể ữ

 Dropped: Ch  cữ ái đ c căn l  gi ng cượ ề ố ác t  còn ừ
l i c a văn b n.ạ ủ ả

 In Margin: Ch  cữ ái n m ngoằ ài l  đo n văn b n.ề ạ ả
 Ch n font ch : Nh n vào h p ọ ữ ấ ộ Font r i ch n font cho ồ ọ

ch  cái đ u đo n văn.ữ ầ ạ
 Ch n đ  l n c a kọ ộ ớ ủ í t  đ u đo n: Nh p s  ch  dòng ự ầ ạ ậ ố ỉ

vào ô Lines to drop.
 Nh p kho ng cậ ả ách t  đ u đo n đ n ph n còn l i ừ ầ ạ ế ầ ạ

c a đo n vủ ạ ào h pộ  Distance from text.



III/ T o c t văn b nạ ộ ảIII/ T o c t văn b nạ ộ ả
1) B ng thanh công c  Standar:ằ ụ

 Ch n m t ho c nhi u đo n văn b n c n chia c t.ọ ộ ặ ề ạ ả ầ ộ
 B m ch n bi u t ng l nh ấ ọ ể ượ ệ Column trên thanh 

công c , chuy n chu t sang ph i đ  ch n s  c t ụ ể ộ ả ể ọ ố ộ
c n t o r i th  chu t.ầ ạ ồ ả ộ

Bi u t ng ể ượ
Column



III/ T o c t văn b n (tt)ạ ộ ảIII/ T o c t văn b n (tt)ạ ộ ả
2) B ng Menu: Vào menu Format – Columns.ằ

 Trong khung Presets 
ch n m t trong các ki u ọ ộ ể
c t  có s n.ộ ẵ

 Ho c có th  gõ tr c ặ ể ự
ti p s  c t trong ô ế ố ộ
Number of columns.

 Có th  ch n đ  r ng ể ọ ộ ộ
và kho ng cách gi a các ả ữ
c t trong m c ộ ụ Width 
and spacing.

 N u mu n gi a các c t có đ ng k  phân cách thì đánh d u ế ố ữ ộ ườ ẻ ấ
vào Checkbox Line between.



IV/ Đ nh d ng đo n văn b nị ạ ạ ảIV/ Đ nh d ng đo n văn b nị ạ ạ ả
 Các đo n văn trong tài li u phân bi t b i ký hi u k t ạ ệ ệ ở ệ ế

thúc đo n (Khi nh n ạ ấ Enter).
 Đ t con tr  trong đo n c n đ nh d ng.ặ ỏ ạ ầ ị ạ

 S  d ng thanh công c :ử ụ ụ

Canh sát l  trái ề
dòng văn b n ả

(Ctrl+L)

Canh gi a  ữ
dòng văn 

b n (ả Ctrl+E)

Canh sát ph i ả
dòng văn b n ả

(Ctrl+R)

Canh đ u hai ề
biên dòng văn 
b n (ả Ctrl+J)



IV/ Đ nh d ng đo n văn b n (tt)ị ạ ạ ảIV/ Đ nh d ng đo n văn b n (tt)ị ạ ạ ả
 S  d ng Paragraph: ử ụ Format \ Paragraph

Canh l  đo nề ạ

Đ nh kho ng ị ả
cách lề

Kho ng cách gi a ả ữ
đo n này v i đo n kiaạ ớ ạ

Kho ng cách gi a các ả ữ
hàng trong đo nạ



V/ Chèn ký t  đ c bi tự ặ ệV/ Chèn ký t  đ c bi tự ặ ệ
 Vào Insert  Symbol

 Font: Danh sách các nhóm ký hi u.ệ

 Shortcut Key: Đ nh nghĩa t  h p phím t t cho ký hi u đã ị ổ ợ ắ ệ
ch n.ọ



VI/ Đ nh m c d ng (Tab Stop)ị ố ừVI/ Đ nh m c d ng (Tab Stop)ị ố ừ
 Ví d  v  s  d ng Tab Stop:ụ ề ử ụ



VI/ Đ nh m c d ng (tt)ị ố ừVI/ Đ nh m c d ng (tt)ị ố ừ
 D u Tab đ c đ t  đ u mút trái trên thanh ấ ượ ặ ở ầ

th c k  ngang.ướ ẻ

Kí hi u bi u di n ệ ể ễ
d u Tab trên thanh ấ

th c k  ngangướ ẻ

 Các lo i Tab th ng dùng:ạ ườ

 Tab trái: 

 Tab ph i: ả

 Tab gi a: ữ



VI/ Đ nh m c d ng (tt)ị ố ừVI/ Đ nh m c d ng (tt)ị ố ừ
 Cách đ t m c d ng:ặ ố ừ

 Nh n vào ấ bi u t ng d u Tabể ượ ấ  cho đ n khi ế
hi n bi u t ng d u ệ ể ượ ấ Tab thích h p.ợ

 Nh n chu tấ ộ  vào v  trí đ t Tab ị ặ trên thanh th c ướ
 ngang

 Nh n vào ấ phím Tab trên bàn phím đ  con ể
nháy chu t nh y đ n v  trí đ t Tab trên vùng ộ ả ế ị ặ
so n th o.ạ ả

 Gõ văn b n vào, văn b n s  đ c canh theo ả ả ẽ ượ
Tab.



VI/ Đ nh m c d ng (tt)ị ố ừVI/ Đ nh m c d ng (tt)ị ố ừ



VI/ Đ nh m c d ng (tt)ị ố ừVI/ Đ nh m c d ng (tt)ị ố ừ
 Chèn ký hi u phía tr c d u Tab: ệ ướ ấ Vào menu 
Format, ch n ọ Tabs.

Ch n Tab ọ
mu n làm xu t ố ấ

hi n ký hi uệ ệ

Ch n ki u ọ ể
ký hi u đ  ệ ể
xu t hi nấ ệ

Ch n Setọ

Ch n OKọ



VII/ Danh sách li t kêệVII/ Danh sách li t kêệ
 Danh sách li t kê là m t dãy liên ti p các đo n văn ệ ộ ế ạ
b n đ c đánh d u b ng các kí hi u đ t đ u dòng.ả ượ ấ ằ ệ ặ ầ
 Có nhi u cách đ  t o:ề ể ạ

 S  d ng nútử ụ  Bullets

 Hay nút Numbering 

 Ho c t  l nhặ ừ ệ  Format  Bullets and 
Numbering.



VII/ Danh sách li t kê (tt)ệVII/ Danh sách li t kê (tt)ệ
 Tùy ch nh danh sách li t kê: ỉ ệ Kích vào nút Customize

Đánh số 
thứ tự
từ số 
mấy.

Đổi cách 
canh lề

Kiểu chỉ mục 
thứ tự

Thay đổi 
định 
dạng

của số

Khoảng cách từ kí hiệu 
đến đoạn văn

Khoảng cách từ lề giấy 
đến đoạn văn
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S  D NG CÁC CÔNG C  Ử Ụ ỤS  D NG CÁC CÔNG C  Ử Ụ Ụ
HI U CH NH VĂN B NỆ Ỉ ẢHI U CH NH VĂN B NỆ Ỉ Ả



I/ Tìm ki m và thay thế ếI/ Tìm ki m và thay thế ế
1/ Tìm ki m:ế
 Vào menu Edit, ch n ọ Find...
 Trong khung Find what gõ vào đo n văn mu n tìm.ạ ố
 Kích nút Find next đ  tìm ti p. Khi tìm th y thì đo n ể ế ấ ạ

văn đó s  đ c bôi đen.ẽ ượ



I/ Tìm ki m và thay th  (tt)ế ếI/ Tìm ki m và thay th  (tt)ế ế
2/ Thay th :ế
 Vào menu Edit, ch n ọ Replace...
 Nh p văn b n c n thay th  vào khung ậ ả ầ ế Find what
 Nh p văn b n thay vào khung ậ ả Replace with

 Replace: Thay t ng ph n t  đ c tìm th y.ừ ầ ử ượ ấ
 Replace all: Thay th  t t c .ế ấ ả
 Find next: Không thay, tìm ti p.ế



II/ Ti n ích AutoCorrectệII/ Ti n ích AutoCorrectệ
1/ T o m t m c Autocorrect:ạ ộ ụ  Vào menu Tools, ch n ọ

Autocorrect...
 Đánh d u ki m vào h p ấ ể ộ
ch n: ọ Replace text as you 
type

 Nh p tên m c ậ ụ
Autocorrect vào khung 
Replace

 Nh p nôi dung vào ậ
khung With

 Nh n ấ Add

 Nh n ấ OK



II/ Ti n ích AutoCorrect (tt)ệII/ Ti n ích AutoCorrect (tt)ệ
2/ S  d ng Autocorrect: ử ụ Trong khi so n th o, nh p tên ạ ả ậ

m c ụ Autocorrect, nh n ấ Spacebar.
3/ Xóa m t Autocorrect:ộ  Vào menu Tolls, ch n ọ

Autocorrect. Ch n tên ọ Autocorrect c n xóa, nh n ầ ấ
nút Delete.



III/ Ti n ích AutotextệIII/ Ti n ích Autotextệ
1/ T o m i m t m c Autotext:ạ ớ ộ ụ
 Ch n n i dung mu n l u tr  (bao g m văn b n hay ọ ộ ố ư ữ ồ ả

đ  h a).ồ ọ
 Vào menu Insert, ch n ọ Autotext...
 Gõ tên Autotext vào m c ụ Enter Autotext Entries 

here. Nh n ấ Add.
2/ S  d ng Autotext:ử ụ
 Đ a con tr  văn b n đ n v  trí c n chèn ư ỏ ả ế ị ầ Autotext, gõ 

ký t  đã đ nh nghĩa  trên và nh n phím ự ị ở ấ F3.



IV/ Tiêu đ  đ u trang, tiêu đ  chân trangề ầ ềIV/ Tiêu đ  đ u trang, tiêu đ  chân trangề ầ ề
 Vào menu View, ch n ọ Header and Footer...

S  th  t  trangố ứ ự T ng s  trangổ ố Chuy n đ i gi a tiêu ể ổ ữ
đ  đ u trang v i tiêu ề ầ ớ

đ  chân trangề



V/ Đánh s  trangốV/ Đánh s  trangố
 Vào menu Insert, ch n ọ Page numbers...
 Ch n ví trí trong khung ọ Position
 Ch n cách canh trong khung ọ Alignment



VI/ S  d ng ti n ích Change caseử ụ ệVI/ S  d ng ti n ích Change caseử ụ ệ
 Ch n đo n văn b n c n ọ ạ ả ầ Change case.
 Vào menu Format, ch n ọ Change case...

 Sentrence case: Vi t hoa kí t  đ u câu.ế ự ầ
 Lower case: T t c  là ch  th ng.ấ ả ữ ườ
 Upper case: T t c  đ u là ch  in.ấ ả ề ữ
 Title case: Vi t hoa ký t  đ u m i t .ế ự ầ ỗ ừ
 Toggle case: Ng c v i Title case.ượ ớ



VII/ Nh p công th c toán h cậ ứ ọVII/ Nh p công th c toán h cậ ứ ọ
 S  d ng công c  ử ụ ụ Microsoft Equation 3.0
 Vào Insert - Object…- Microsoft Equation 3.0 –  OK 

Xu t hi n m t thanh cấ ệ ộ ông cu ̣ sau:
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B NG BI U VÀ HÌNH NHẢ Ể ẢB NG BI U VÀ HÌNH NHẢ Ể Ả



I/ T o m i m t b ng bi uạ ớ ộ ả ểI/ T o m i m t b ng bi uạ ớ ộ ả ể
1/ S  d ng thanh công c :ử ụ ụ
 D i con tr  đ n n i c n t o b ng bi u.ờ ỏ ế ơ ầ ạ ả ể
 B m ch n bi u t ng ấ ọ ể ượ Insert Table – Rê chu t ch n ộ ọ

s  hàng c t c n thi t.ố ộ ầ ế



I/ T o m i m t b ng bi u (tt)ạ ớ ộ ả ểI/ T o m i m t b ng bi u (tt)ạ ớ ộ ả ể
2/ Dùng menu:
 D i con tr  đ n n i c n t o b ng bi u.ờ ỏ ế ơ ầ ạ ả ể
 Vào menu Table, ch n ọ Insert\ Table...

 Nh p s  c t vào khung ậ ố ộ Number of Columns
 Nh p s  dòng vào khung ậ ố Number of Rows
 Trong khung Column width nh p vào đ  r ng c t ậ ộ ộ ộ

- th ng ch n ườ ọ Auto. Nh n OKấ



II/ Di chuy n con nháy trong b ngể ảII/ Di chuy n con nháy trong b ngể ả
 Tab: D i con tr  sang ô bên ph i so v i ô hi n t i.ờ ỏ ả ớ ệ ạ
 Shift+Tab: D i con tr  sang ô bên trái so v i ô hi n ờ ỏ ớ ệ

t i.ạ
 Các phím mũi tên: Di chuy n con tr  theo chi u ể ỏ ề

t ng ng.ươ ứ
 Alt+Home: V  ô đ u tiên trong hàng.ề ầ
 Alt+End: V  ô cu i cùng trong hàng.ề ố
 Alt+Page Up: V  ô đ u tiên trong c t.ề ầ ộ
 Alt+Page Down: V  ô cu i cùng trong c t.ề ố ộ
 Ctrl+Tab: Đ a con tr  đ n v  trí Tab Stop đã đ nh.ư ỏ ế ị ị



III/ Ch n m t dòng, c t hay ôọ ộ ộIII/ Ch n m t dòng, c t hay ôọ ộ ộ
 Nh n chu t vào ấ ộ l  tráiề  c a m t dòng ủ ộ đ  ch n đ c ể ọ ượ

c  dòngả .
 Di chuy n con tr  chu t vào đ n ể ỏ ộ ế m p l  trên đ nh ế ề ỉ

c tộ , khi con tr  chu t có d ng ỏ ộ ạ mũi tên màu đen thì 
nh n chu t ấ ộ ch n c  c t.ọ ả ộ

 Di chuy n con tr  chu t đ n ể ỏ ộ ế l  tráiề  c a ô đ n khi ủ ế
thành mũi tên màu đen thì nh n chu t đ  ấ ộ ể ch n m t ọ ộ
ô. N u ch n nhi u ô thì nh n chu t kéo và th .ế ọ ề ấ ộ ả

 Ta có th  ch n nhi u dòng hay nhi u c t b ng cách ể ọ ề ề ộ ằ
kích chu t ộ kéo và thả



IV/ Thay đ i c u trúc c a b ngổ ấ ủ ảIV/ Thay đ i c u trúc c a b ngổ ấ ủ ả
1) Thêm dòng: Vào Table – Insert - Rows Above hay 

Rows Below (Dòng m i thêm vào s  chèn vào ớ ẽ phía 
trên hay phía d iướ  c a dòng đang ch a con tr ).ủ ứ ỏ

2) Thêm c t:ộ  Vào Table – Insert - Columns to the left 
hay Columns to the right (Côṭ m i thêm vào s  chèn ớ ẽ
vào bên traí hay bên phaỉ c a ủ côt ̣ có ch a con tr ).ứ ỏ

3) Thêm ô: Vaò Table - Insert - Cells -> xuât hiên môt ́ ̣ ̣
c a sô:ử ̉

D ch các ô v  phía ph iị ề ả
D ch các ô xu ng d iị ố ướ

Chèn c  hàngả

Chèn c  c tả ộ



IV/ Thay đ i c u trúc c a b ng (tt)ổ ấ ủ ảIV/ Thay đ i c u trúc c a b ng (tt)ổ ấ ủ ả
4) Xóa dòng, c t hay c  b ng:ộ ả ả  

 Ch n các dòng, c t hay b ng c n xóa.ọ ộ ả ầ
 Vào Table - Delete - Columns/Rows/Table (Xóa côṭ / 

dòng / b ngả ).
5) Xóa ô:

 Ch n các ô mu n xóa.ọ ố
 Vaò Table - Delete – Cells -> xuât hiên môt c a sô:́ ̣ ̣ ử ̉

D ch các ô còn l i v  phía tráiị ạ ề
D ch các ô còn l i xu ng d iị ạ ố ướ

Xóa c  hàngả

Xóa c  c tả ộ



IV/ Thay đ i c u trúc c a b ng (tt)ổ ấ ủ ảIV/ Thay đ i c u trúc c a b ng (tt)ổ ấ ủ ả
6) Tr n nhi u ô thành m t ô: ộ ề ộ Ch n các ô mu n tr n. ọ ố ộ

Vào menu Table – Merge Cells.
7) Chia m t ô thành nhi u ô:ộ ề  Ch n ô mu n chia. Vào ọ ố

menu Table – Split Cells. Xu t hi n h p tho i:ấ ệ ộ ạ

Nh p vào s  c t c n chia ra ậ ố ộ ầ
t  ô đã ch nừ ọ

Nh p vào s  hàng c n chia ra ậ ố ầ
t  ô đã ch nừ ọ



IV/ Thay đ i c u trúc c a b ng (tt)ổ ấ ủ ảIV/ Thay đ i c u trúc c a b ng (tt)ổ ấ ủ ả
8) Chia m t b ng thành nhi u b ng:ộ ả ề ả

 Đ t con tr  trong hàng mà ta mu n là hàng đ u tiên c a ặ ỏ ố ầ ủ
b ng m i.ả ớ

 Vào menu Table – Split Table.
9) Thay đ i đ  r ng c a c t, chi u cao c a hàng:ổ ộ ộ ủ ộ ề ủ

 Di chuy n con tr  chu t đ n đ ng biên c a c t ho c ể ỏ ộ ế ườ ủ ộ ặ
hàng c n thay đ i, khi con tr  chu t bi n thành mũi màu ầ ổ ỏ ộ ế
đen 2 chi u thì kéo và th  chu t.ề ả ộ



IV/ Thay đ i c u trúc c a b ng (tt)ổ ấ ủ ảIV/ Thay đ i c u trúc c a b ng (tt)ổ ấ ủ ả
10) Đóng khung, tô bóng m : ờ N u mu n áp d ng thay ế ố ụ

đ i cho toàn b ng thì đ t con tr  vào m t v  trí b t kỳ ổ ả ặ ỏ ộ ị ấ
trong b ng.ả

 Đóng khung:
 Ch n kh i ô mu n đóng khung.ọ ố ố
 Vào menu Format – Borders and Shading, Ch n ọ Boder 

tab. Xu t hi n h p tho i:ấ ệ ộ ạ



IV/ Thay đ i c u trúc c a b ng (tt)ổ ấ ủ ảIV/ Thay đ i c u trúc c a b ng (tt)ổ ấ ủ ả

 Tô bóng m :ờ  Cũng trong c a s  ử ổ Borders and Shading, ch n ọ
qua tab Shading.



V/ Thay đ i h ng văn b n trong ôổ ướ ảV/ Thay đ i h ng văn b n trong ôổ ướ ả
 Ch n kh i ô c n thay đ i h ng.ọ ố ầ ổ ướ

 Vào Format  -> Text Direction



VI/ Thêm hình nh vào tài li uả ệVI/ Thêm hình nh vào tài li uả ệ
 Vào menu Insert – Picture – Clip Art
 Ch n m t hình nh t  danh m c hình nh có s n ọ ộ ả ừ ụ ả ẵ

trong b  ộ Office. Kích chu t ph i vàộ ả  chon ̣ Insert hay 
kích chu t trái và ch n vào bi u t ng ộ ọ ể ượ Insert Clip.

 N u mu n chèn ế ố
hình nh t  b t kỳ ả ừ ấ
m t t p tin nào nh ộ ệ ả
nào đó trong máy thì 
vào: Insert – Picture 
– From File

 Đ nh d ng l i ị ạ ạ
hình: Nháy ph i chu t ả ộ
vào hình c n đ nh ầ ị
d ng, ch n ạ ọ Format 
Picture.



VII/ T o ch  ngh  thu tạ ữ ệ ậVII/ T o ch  ngh  thu tạ ữ ệ ậ
 Vao ̀ Insert - Picture - WordArt hoăc co thê kich lên ̣ ́ ̉ ́

biêu t ng ̉ ượ Word Art           trên thanh Drawing.

Chon môt kiêu ch  ̣ ̣ ̉ ữ
nghê thuât va chon ̣ ̣ ̀ ̣ OK

Ch n l i ọ ạ Font và Go lai ̃ ̣
dong ch  mong muôǹ ữ ́ .



VIII/ Thêm các kh i hình h c vào tài li uố ọ ệVIII/ Thêm các kh i hình h c vào tài li uố ọ ệ

Chon môt ̣ ̣ kh i ố hinh hoc co săn ̀ ̣ ́ ̃
trong th  viên nayư ̣ ̀ , dung chuôt ̀ ̣

keo va vé ̀ ̃ ra trong vung soan thaò ̣ ̉



IX/ Chèn bi u đ  vào tài li uể ồ ệIX/ Chèn bi u đ  vào tài li uể ồ ệ
 Vao menu ̀ Insert - Picture - Chart



BÀI 6BÀI 6

TI N ÍCH TR N THỆ Ộ ƯTI N ÍCH TR N THỆ Ộ Ư



I/ Ý nghĩa c a vi c tr n thủ ệ ộ ưI/ Ý nghĩa c a vi c tr n thủ ệ ộ ư
 Đây là công vi c hay làm trong vi c t o ra các gi y ệ ệ ạ ấ

m i, th  t , phi u báo đi m,… cùng m t n i dung ờ ư ừ ế ể ộ ộ
cho nhi u ng i, nhi u c  quan,…ề ườ ề ơ

 Thao tác này cho phép chúng ta tr n 2 văn b n đã ộ ả
so n th o thành m t văn b n “k t qu ” theo m t th  ạ ả ộ ả ế ả ộ ứ
t  cho tr c.ự ướ



II/ Chu n b  văn b n tr nẩ ị ả ộII/ Chu n b  văn b n tr nẩ ị ả ộ
 T o văn b n th  nh t có n i dung s  c  đ nh trong ạ ả ứ ấ ộ ẽ ố ị

văn b n “k t qu ”, gi  s  văn b n đ c l u v i tên: ả ế ả ả ử ả ượ ư ớ
Phieu_bao_diem.doc

 T o văn b n th  2 có n i dung s  là các m c đ c ạ ả ứ ộ ẽ ụ ượ
tr n vào văn b n th  nh t, gi  s  văn b n đ c l u ộ ả ứ ấ ả ử ả ượ ư
v i tên: ớ Danh_sach_diem.doc. V i văn b n th  2 ớ ả ứ
này, n i dung c a chúng là m t b ng bi u v i các ộ ủ ộ ả ể ớ
c t t ng ng là các tr ng c n tr n và các dòng là ộ ươ ứ ườ ầ ộ
n i dung t ng ng cho t ng tr ng.ộ ươ ứ ừ ườ



II/ Chu n b  văn b n tr n (tt)ẩ ị ả ộII/ Chu n b  văn b n tr n (tt)ẩ ị ả ộ



III/ Thao tác tr nộIII/ Thao tác tr nộ
 M  văn b n th  nh t (Phieu_bao_diem.doc)ở ả ứ ấ
 Vào menu Tools – Mail Merge. Xu t hi n h p tho i ấ ệ ộ ạ

Mail Merger Helper v i n i dung nh  sau:ớ ộ ư



III/ Thao tác tr n (tt)ộIII/ Thao tác tr n (tt)ộ
 M c ụ Main document: Cho phép chúng ta ch n tài ọ

li u chính c n tr n (tài li u th  nh t). V i cách th c ệ ầ ộ ệ ứ ấ ớ ự
hi n này h  th ng s  ng m hi u tài li u chính là tài ệ ệ ố ẽ ầ ể ệ
li u đang m .ệ ở

 M c ụ Data source: Cho phép chúng ta ch n tài li u ọ ệ
ph  c n tr n vào tài li u chính (tài li u th  2).ụ ầ ộ ệ ệ ứ

 M c ụ Merge the data with the document: Ch p ấ
nh n tr n n i dung c a 2 tài li u đã ch n.ậ ộ ộ ủ ệ ọ



III/ Thao tác tr n (tt)ộIII/ Thao tác tr n (tt)ộ
 T  nút l nh ừ ệ Create -> 

Form letter -> Ch n ọ
Active Windows khi 
h p tho i Microsoft ộ ạ
Windows xu t hi n.ấ ệ

 T  nút l nh ừ ệ Get data -> 
Open data source -> 
Ch n đ ng d n và xác ọ ườ ẫ
đ nh cho h  th ng bi t ị ệ ố ế
đ a ch  c a t p tin th  2 ị ỉ ủ ệ ứ
c n tr n -> ầ ộ Ch n Edit ọ
main document khi 
h p tho i Microsoft ộ ạ
Windows xu t hi n.ấ ệ



III/ Thao tác tr n (tt)ộIII/ Thao tác tr n (tt)ộ
 Lúc này h  th ng s  t  đ ng đ a ra thanh c ng c  ệ ố ẽ ự ộ ư ộ ụ Mail 

Merge:



III/ Thao tác tr n (tt)ộIII/ Thao tác tr n (tt)ộ
 Menu Insert Merge Field: Danh sách các tr ng c n ườ ầ

tr n t ng ng trong t p tin th  2.ộ ươ ứ ệ ứ
 L n l t chèn tên các tr ng vào v  trí c n tr n.ầ ượ ườ ị ầ ộ
 Nút l nh ệ Merge… trên thanh công c  cho phép b t ụ ắ

đ u công vi c tr n v i các ch c năng sau:ầ ệ ộ ớ ứ
 Merge to: Ch n n i s  xu t hi n văn b n k t qu .ọ ơ ẽ ấ ệ ả ế ả
 Record to be merged: Ch n s  l ng b n ghi s  tr n.ọ ố ượ ả ẽ ộ



IV/ Nâng cao ch c năng tr n thứ ộ ưIV/ Nâng cao ch c năng tr n thứ ộ ư
 Trong phi u báo đi m trong danh sách trên còn có m t dòng ế ể ộ

“Kêt qu :…”. Gi  s  kêt qu  đ c tính v i yêu c u nh  sau: ả ả ử ả ượ ớ ầ ư
N u T ng đi m >=15 thì đ u, ng c l i thì R t.ế ổ ể ậ ượ ạ ớ

 V i yêu c u nh  v y thì ta s  d ng thêm ch c năng sau: ớ ầ ư ậ ử ụ ứ
Vào menu Insert Word Field -> If…Then…Else…

 Xu t hi n h p tho i sau:ấ ệ ộ ạ



IV/ Nâng cao ch c năng tr n thứ ộ ưIV/ Nâng cao ch c năng tr n thứ ộ ư

 If <Đi u ki n> ề ệ Then <Câu l nh 1> ệ Else <Câu l nh 2>:ệ
N u Đi u ki n đúng thì th c hi n Câu l nh 1, ng c l i Đi u ế ề ệ ự ệ ệ ượ ạ ề
ki n sai thì th c hi n Câu l nh 2.ệ ự ệ ệ



IV/ Nâng cao ch c năng tr n th  (tt)ứ ộ ưIV/ Nâng cao ch c năng tr n th  (tt)ứ ộ ư
 Field name: Tr ng c n so sánh.ườ ầ
 Comparison: Bi u th c so sánh:ể ứ

 Equal to: B ngằ
 Not equal to: Không b ngằ
 Less than: Nh  h nỏ ơ
 Greater than: L n h nớ ơ
 Less than or equal: Nh  h n ho c b ngỏ ơ ặ ằ
 Greater than or equal: L n h n ho c b ngớ ơ ặ ằ
 Is blank: Là r ngỗ
 Is not blank: Không là r ngỗ

 Compare to: Giá tr  so sánh.ị
 Insert this text: Giá tr  khi bi u th c so sánh đúng.ị ể ứ
 Otherwise insert this text: Giá tr  khi bi u th c so ị ể ứ

sánh sai.
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IN N & THI T Đ T Ấ Ế ẶIN N & THI T Đ T Ấ Ế Ặ
M T KH UẬ ẨM T KH UẬ Ẩ



I/ Xem tr c khi inướI/ Xem tr c khi inướ
 Thao tác này cho phép xem nhanh toàn b  hình dáng ộ

th t c a văn b n khi k t xu t văn b n ra máy in (in ra ậ ủ ả ế ấ ả
gi y).ấ

 Vào menu File -> Print preview ho c nh n bi u ặ ấ ể
t ng ượ Preview trên thanh công c .ụ

 Thanh công c  liên quan: Thanh ụ Print preview:

Th c hi n Inự ệ

S a n i dungử ộ

Xem t ng trangừ

Xem nhi u trangề

Phóng to, thu nh  ỏ
màn hình xem



II/ Th c hi n inự ệII/ Th c hi n inự ệ
 Vào menu File -> Print (Ho c nh n t  h p phím ặ ấ ổ ợ

Ctrl+P).

Collate: Ch n th  t  in trong tr ng h p in nhi u l n cho m t ọ ứ ự ườ ợ ề ầ ộ
trang.

 Page range: Ch n ọ
s  trang in.ố

 Copies: Ch n s  l n ọ ố ầ
in cho m t trang.ộ



III/ Thi t đ t m t kh uế ặ ậ ẩIII/ Thi t đ t m t kh uế ặ ậ ẩ
 Vào Tools - Option… Ch n th  ọ ẻ Save (ho c vàoặ  

menu File -> Save as…Tools -> General Options…)
 Gõ m t kh u b o v  khi m  vào h p văn b n ậ ẩ ả ệ ở ộ ả

Password to open và m t kh u b o v  c u trúc ậ ẩ ả ệ ấ
(n u mu n) vào h p ế ố ộ Password to modify.



Module 5Module 5   

B NG TÍNH ĐI N T  Ả Ệ ỬB NG TÍNH ĐI N T  Ả Ệ Ử
MICROSOFT EXCELMICROSOFT EXCEL



BÀI 1BÀI 1

KH I Đ NG VÀ GI I Ở Ộ ỚKH I Đ NG VÀ GI I Ở Ộ Ớ
THI U CÁC THÀNH ỆTHI U CÁC THÀNH Ệ
PH N GIAO DI NẦ ỆPH N GIAO DI NẦ Ệ



I/ Kh i đ ng Excelở ộI/ Kh i đ ng Excelở ộ
 S  d ng các cách kh i đ ng Excel gi ng nh  các ử ụ ở ộ ố ư

cách đã kh i đ ng Word.ở ộ
 T p tin Excel sinh ra m c đ nh có ph n m  r ng là ệ ặ ị ầ ở ộ

XLS



II/ C u t o b ng tính MS-Excelấ ạ ảII/ C u t o b ng tính MS-Excelấ ạ ả

Sheet1, Sheet2, Sheet3 
là 3 Worksheet m c ặ

đ nh c a m t Workbookị ủ ộ

Vùng b ng tínhả

Thanh công th cứ



II/ C u t o b ng tính MS-Excel (tt)ấ ạ ảII/ C u t o b ng tính MS-Excel (tt)ấ ạ ả
 Sau khi kh i đ ng Excel, chúng ta có m t c a s  ở ộ ộ ử ổ

b ng tính (ả Workbook).
 Trong m t b ng tính có nhi u trang b ng tính ộ ả ề ả

(Worksheet).
 M t ộ Workbook có t i đa ố 255 Worksheet.
 Trên m t ộ Worksheet đ c chia thành nhi u c t và ượ ề ộ

nhi u dòng. Bao g m ề ồ 256 c tộ  và 65536 dòng.
 C t (Columns): Đ c kí hi u b ng các ch  cái ộ ượ ệ ằ ữ A, B,

…,Z, AA,…,IV
 Dòng (Rows): Đ c đánh s  th  t  b ng các ch  s  ượ ố ứ ự ằ ữ ố

1, 2, 3,…,65536



II/ C u t o b ng tính MS-Excel (tt)ấ ạ ảII/ C u t o b ng tính MS-Excel (tt)ấ ạ ả
 Ô (Cell): Giao c a m t dòng và m t c t g i là ô.ủ ộ ộ ộ ọ
 Ô đ c xác đ nh b i m t t a đ  (g i là đ a ch  ô) d a ượ ị ở ộ ọ ộ ọ ị ỉ ự

theo kí hi u c a c t và s  th  t  c a dòng.ệ ủ ộ ố ứ ự ủ

Đ a ch  c a ô là ị ỉ ủ B2

Đ a ch  c a ô là ị ỉ ủ C5



BÀI 2BÀI 2

CÁC THAO TÁC C  ƠCÁC THAO TÁC C  Ơ
B N TRÊN B NG Ả ẢB N TRÊN B NG Ả Ả

TÍNH EXCELTÍNH EXCEL



I/ Nh p d  li uậ ữ ệI/ Nh p d  li uậ ữ ệ
1/ Nh p d  li u ki u s , ki u ngày tháng:ậ ữ ệ ể ố ể
 D  li u ki u s  đ c nh p vào m c đ nh n m bên ữ ệ ể ố ượ ậ ặ ị ằ

ph i c a ô.ả ủ
 Mu n nh p s  có ố ậ ố ph n th p phânầ ậ , đánh d u ấ “.” 

(bên ph i bàn phím) vào gi a ph n nguyên và ph n ả ữ ầ ầ
th p phân.ậ

 Ki u ngày tháng nên nh p theo đ nh d ng ể ậ ị ạ
ngày/tháng/năm c a Vi t Nam (ủ ệ dd/mm/yyyy).

2/ Nh p d  li u ki u văn b n:ậ ữ ệ ể ả
 D  li u ki u văn b n đ c nh p vào m c đ nh n m ữ ệ ể ả ượ ậ ặ ị ằ

bên trái c a ô.ủ
 Đ  nh p ki u s  d ng văn b n thì nh p s  đ ng sau ể ậ ể ố ạ ả ậ ố ằ

d u nháy đ n ấ ơ ‘



II/ Hi u ch nh b ng tínhệ ỉ ảII/ Hi u ch nh b ng tínhệ ỉ ả
1/ Ch n, sao chép, di chuy n vùng b ng tính:ọ ể ả  Th c ự

hi n các thao tác gi ng nh  trên Windows.ệ ố ư
2/ Chèn thêm dòng: Dòng trong Excel đ c chèn s  ượ ẽ

n m bên trên dòng hi n t i. Vào menu ằ ệ ạ Insert -> 
Rows.

3/ Chèn thêm c t:ộ  C t trong Excel đ c chèn s  n m ộ ượ ẽ ằ
bên trái c t hi n t i. Vào menu ộ ệ ạ Insert -> Columns.

4/ Xóa dòng, c t:ộ  Ch n nh ng dòng, c t c n xóa. Nháy ọ ữ ộ ầ
ph i chu t vào nh ng dòng, c t đã ch n ả ộ ữ ộ ọ -> Delete.

5/ Thay đ i đ  r ng c a c t và chi u cao c a dòng:ổ ộ ộ ủ ộ ề ủ  
Di chuy n chu t vào v  trí giao gi a 2 tên c t, ho c ể ộ ị ữ ộ ặ
dòng, khi đó con tr  chu t chuy n thành mũi tên 2 ỏ ộ ể
chi u, kéo và th . (Ho c ề ả ặ Format -> Column/Row -> 
Width/Height).



III/ Hi n th  hay che d u c t và dòngể ị ấ ộIII/ Hi n th  hay che d u c t và dòngể ị ấ ộ
 Đ  n các c t hay ể ẩ ộ

dòng ta ch n các c t ọ ộ
hay dòng đó, kích 
chu t ph i ộ ả -> Hide

 Đ  hi n th  l i các ể ể ị ạ
c t hay dòng, ta ch n ộ ọ
các c t hay dòng có ộ
ch a các c t hay ứ ộ
dòng b  n đó, kích ị ẩ
chu t ph i ộ ả -> Unhide



IV/ C  đ nh dòng tiêu đ , c t tiêu đố ị ề ộ ềIV/ C  đ nh dòng tiêu đ , c t tiêu đố ị ề ộ ề
 Khi nh p b ng tính có nhi u c t, nhi u dòng, chúng ậ ả ề ộ ề

ta có nhu c u mu n c  đ nh dòng/c t tiêu đ  trong ầ ố ố ị ộ ề
khi các dòng/c t d i đ c phép cu n lên ho c cu n ộ ướ ượ ộ ặ ộ
xu ng.ố

 Các b c th c hi n:ướ ự ệ
 Đ a con tr  t i b t kỳ ô nào n m  d i dòng tiêu đ .ư ỏ ớ ấ ằ ở ướ ề
 Vào menu Window, ch n ọ Freeze Panes.

 Mu n g  b  vi c c  đ nh tiêu đ : Vào menu ố ỡ ỏ ệ ố ị ề
Window, ch n ọ Unfreeze Panes.



V/ Công c  đi n n i dung t  đ ngụ ề ộ ự ộV/ Công c  đi n n i dung t  đ ngụ ề ộ ự ộ
1/ Đi n t  đ ng theo c p s  c ng (S  d ng phím ề ự ộ ấ ố ộ ử ụ Ctrl):
 Nh p s  1 vào ô A2.ậ ố
 Nh n gi  phím ấ ữ Ctrl.
 Đ a chu t vào ư ộ góc d i bên ph iướ ả  c a ô, khi con tr  ủ ỏ

chu t bi n thành 2 d u c ng (d u l n và d u nh ).ộ ế ấ ọ ấ ớ ấ ỏ
 Kéo và th  s  cho k t qu .ả ẽ ế ả

Tr c khi ướ
kéo

Sau khi 
kéo



V/ Công c  đi n n i dung t  đ ng (tt)ụ ề ộ ự ộV/ Công c  đi n n i dung t  đ ng (tt)ụ ề ộ ự ộ
2/ Đi n t  đ ng theo c p s  c ng:ề ự ộ ấ ố ộ
 Nh p 2 s  vào 2 ô trên d i liên ti p nhau. ậ ố ướ ế Công sai 

c a c p s  c ng là ủ ấ ố ộ hi uệ  c a s  d i v i s  trên.ủ ố ướ ớ ố
 Ch n c  2 ô v a nh p s . Đ a chu t vào góc d i ọ ả ừ ậ ố ư ộ ướ

bên ph i c a ô d i, khi con tr  chu t bi n thành ả ủ ướ ỏ ộ ế
d u c ng thì ấ ọ kéo và thả.



V/ Công c  đi n n i dung t  đ ng (tt)ụ ề ộ ự ộV/ Công c  đi n n i dung t  đ ng (tt)ụ ề ộ ự ộ
3/ Đi n t  đ ng theo c p s  nhân:ề ự ộ ấ ố
 Nh p 2 s  vào 2 ô trên d i liên ti p nhau. ậ ố ướ ế Công b i ộ

c a c p s  c ng là ủ ấ ố ộ th ngươ  c a s  d i v i s  trên.ủ ố ướ ớ ố
 Ch n c  2 ô v a nh p s . Đ a chu t vào góc d i ọ ả ừ ậ ố ư ộ ướ

bên ph i c a ô d i, khi con tr  chu t bi n thành ả ủ ướ ỏ ộ ế
d u c ng thì kích ph i chu t ấ ọ ả ộ kéo và thả. M t menu ộ
ng  c nh xu t hi n, ch n ữ ả ấ ệ ọ Growth Trend.



VI/ Các thao tác v i trang b ng tínhớ ảVI/ Các thao tác v i trang b ng tínhớ ả
1/ Chèn thêm m t Worksheet vào Workbook:ộ
 Worksheet m i đ c chèn vào s  n m bên trái ớ ượ ẽ ằ

Worksheet hi n t i.ệ ạ
 Vào menu Insert -> Worksheet
 Ho c kích chu t ph i lên m t Worksheet b t kỳ, ặ ộ ả ộ ấ

ch n ọ Insert… -> Worksheet
2/ Đ i tên m t Worksheet:ổ ộ  Kích chu t ph i lên ộ ả

Worksheet c n đ i tên và ch n ầ ổ ọ Rename (Ho c kích ặ
đúp chu t lên Worksheet).ộ

3/ Xóa m t Worksheet:ộ  Kích ph i chu t lên Worksheet ả ộ
c n xóa và ch n ầ ọ Delete.



VI/ Các thao tác v i trang b ng tính (tt)ớ ảVI/ Các thao tác v i trang b ng tính (tt)ớ ả
4/ Sao chép hay di 

chuy n Worksheet:ể
 Cách 1: Dùng chu t ộ

kéo và th  (n u gi  ả ế ữ
thêm phím Ctrl trong 
khi kéo và th  thì th c ả ự
hi n thao tác sao ệ
chép)

 Cách 2: Kích chu t ộ
ph i lên Worksheet ả
mu n di chuy n và ố ể
ch n ọ Move or Copy…

Dùng đ  sao ể
chép



BÀI 3BÀI 3

Đ NH D NG B NG TÍNHỊ Ạ ẢĐ NH D NG B NG TÍNHỊ Ạ Ả



I/ Đ nh d ng d  li u ki u sị ạ ữ ệ ể ốI/ Đ nh d ng d  li u ki u sị ạ ữ ệ ể ố
 C n ch nh các thông ầ ỉ

s  thích h p trong ố ợ
Regional Options.

 Ch n vùng b ng tính ọ ả
c n đ nh d ng.ầ ị ạ

 Vào menu Format -> 
Cells…

 Đ ng  Tab Number.ứ ở
 Ch n m c Number.ọ ụ
 Decimal places: S  ố

ch  s  th p phân.ữ ố ậ
 Use 1000 Separator 

(,): S  d ng d u ử ụ ấ
ngăn cách hàng 
ngàn. Negative numbers: Các cách th  hi n cho s  âm.ể ệ ố

 Đ nh d ng ki u ngày tháng:ị ạ ể  Ch n ọ dd/mm/yyyy trong 
Custom



II/ Đ nh d ng d  li u ki u ngày tháng và ti n tị ạ ữ ệ ể ề ệII/ Đ nh d ng d  li u ki u ngày tháng và ti n tị ạ ữ ệ ể ề ệ

 Ki u ngày tháng:ể  Ch n đ nh d ng ọ ị ạ dd/mm/yyyy 
trong m c ụ Custom c a Tab ủ Number.

 Ki u ti n t :ể ề ệ  Ch n đ nh d ng ọ ị ạ #,### [$ VNĐ] trong 
m c ụ Custom c a Tab ủ Number.



III/ Đ nh d ng ô ch a văn b nị ạ ứ ảIII/ Đ nh d ng ô ch a văn b nị ạ ứ ả
 Vào menu Format -> Cells…
 Đ ng  Tab ứ ở Alignment.



III/ Đ nh d ng ô ch a văn b n (tt)ị ạ ứ ảIII/ Đ nh d ng ô ch a văn b n (tt)ị ạ ứ ả
 Horizotal: Các đ nh d ng l  canh cho d  li u trong ô ị ạ ề ữ ệ

theo chi u n m ngang.ề ằ
 Vertical: Các đ nh d ng l  canh cho d  li u trong ô ị ạ ề ữ ệ

theo chi u th ng đ ng.ề ẳ ứ
 Orientation: Xác đ nh h ng nghiêng cho d  li u ị ướ ữ ệ

trong ô.
 Wrap text: T  đ ng ng t dòng trong tr ng h p đ  ự ộ ắ ườ ợ ộ

r ng c a ô nh  h n chi u dài c a chu i.ộ ủ ỏ ơ ề ủ ỗ
 Shrink to fit: T  đ ng đi u ch nh c  ch  (Không ự ộ ề ỉ ỡ ữ

thay đ i ổ Size ch ) trong tr ng h p đ  r ng c a ô ữ ườ ợ ộ ộ ủ
nh  h n chi u dài c a chu i.ỏ ơ ề ủ ỗ

 Merge cells: Tr n nhi u ô l i thành m t ô. (Ho c có ộ ề ạ ộ ặ
th  kích chu t l n bi u t ng g p ô ể ộ ệ ể ượ ộ trên thanh 
đ nh d ng).ị ạ



BÀI 4BÀI 4

CÔNG TH C VÀ HÀMỨCÔNG TH C VÀ HÀMỨ



I/ T o công th c c  b nạ ứ ơ ảI/ T o công th c c  b nạ ứ ơ ả
 Công th c đ c t o ra nh m m c đích đ  tính toán ứ ượ ạ ằ ụ ể

và tr  l i giá tr  cho b ng tính.ả ạ ị ả
 Ph i nh p d u ả ậ ấ = tr c m i công th c.ướ ọ ứ

Thanh công th cứ



II/ Các toán t  trong công th cử ứII/ Các toán t  trong công th cử ứ
 Toán t  liên k t chu i: ử ế ỗ &

 N i chu i v i chu i: ố ỗ ớ ỗ “Tin”&” H c”ọ  -> Tin H cọ
 N i s  v i s : ố ố ớ ố 123&456 -> 123456
 N i s  v i chu i: ố ố ớ ỗ “Excel “&2000 -> Excel 2000
 N i chu i v i m t bi u th c s  h c:ố ỗ ớ ộ ể ứ ố ọ

“Phim “&2002/2&”đêm” -> Phim 1001 đêm
 N i chu i v i hàm: ố ỗ ớ “T ng s  là “&Sum(10;20)ổ ố  -> 

T ng s  là 30ổ ố
 Toán t  so sánh: ử >, <, >=, <=, =, <>

 Các bi u th c so sánh luôn cho k t qu  là m t giá ể ứ ế ả ộ
tr  ị logic (True hay False)

 Ví d : ụ 240<350 -> True
250=360-100 -> False



III/ Các lo i đ a chạ ị ỉIII/ Các lo i đ a chạ ị ỉ
 Đ a ch  t ng đ i:ị ỉ ươ ố  Lo i đ a ch  này khi sao chép ạ ị ỉ

công th c s  b  thay đ i đ a ch  dòng ho c đ a ch  ứ ẽ ị ổ ị ỉ ặ ị ỉ
c t.ộ

 Đ a ch  tuy t đ i:ị ỉ ệ ố  S  không b  thay đ i đ a ch  dòng ẽ ị ổ ị ỉ
và đ a ch  c t khi sao chép công th c. Kí hi u đ a ch  ị ỉ ộ ứ ệ ị ỉ
tuy t đ i: ệ ố $C t$Dòng.ộ

 Đ a ch  h n h p:ị ỉ ỗ ợ
 Tuy t đ i dòng:ệ ố  S  không b  thay đ i đ a ch  dòng. Kí ẽ ị ổ ị ỉ

hi u: ệ C t$Dòng.ộ
 Tuy t đ i c t:ệ ố ộ  Đ a ch  c t không thay đ i. Kí hi u: ị ỉ ộ ổ ệ

$C tDòng.ộ



IV/ Các hàm c  b n trên Excelơ ảIV/ Các hàm c  b n trên Excelơ ả
 Sau khi tính toán hàm s  tr  v  ẽ ả ề m t giá trộ ị (s , ố

chu i,…)ỗ
 D ng th c chung c a hàm:ạ ứ ủ

<TÊN HÀM>(Đ i s  1, đ i s  2,..., đ i s  n)ố ố ố ố ố ố

 M t hàm có th  có m t đ i s , nhi u đ i s , ho c có ộ ể ộ ố ố ề ố ố ặ
hàm không có đ i s  nào.ố ố

 Các đ i s  trong hàm ngăn cách nhau b i ố ố ở d u ph y ấ ẩ
(,) hay d u ch m ph y (;)ấ ấ ẩ  là tùy thu c vào vi c thi t ộ ệ ế
đ t trong ặ Regional Options c a m i máy.ủ ỗ

 Ví d :ụ  =SUM(10;C8;A2:C6)

Tên hàm Các đ i số ố



1/ Khái ni m đ i s  (hay tham s )ệ ố ố ố1/ Khái ni m đ i s  (hay tham s )ệ ố ố ố
 Đ i s  có th  là:ố ố ể

 M t giá tr  ki u s  (Ví d : 6)ộ ị ể ố ụ
 M t chu i ký t  (Ví d : “TP”)ộ ỗ ự ụ
 M t đ a ch  ô hay vùng đ a ch  ô (Ví d : A2 hay A3: E9)ộ ị ỉ ị ỉ ụ
 Tên vùng (Ví d : NKCNO)ụ
 Bi u th c đ i s  (Ví d : 2*3+6/4)ể ứ ạ ố ụ
 Nh ng hàm khác.ữ



2/ Các hàm toán h cọ2/ Các hàm toán h cọ
 Hàm SUM:

 Cú pháp: =SUM(đ i s  1; đ i s  2;…;đ i s  n)ố ố ố ố ố ố
 Công d ng:ụ  Tính t ng các đ i s .ổ ố ố
 Chú ý: Đ i s  ph i là m t giá tr  ki u s , có t i đa 30 đ i ố ố ả ộ ị ể ố ố ố

s .ố
 Ví d :ụ  =SUM(10;20;30) -> 60

 Hàm ABS
 Cú pháp: =ABS(đ i s )ố ố
 Công d ng:ụ  Hàm s  tr  v  giá tr  tuy t đ i c a đ i s .ẽ ả ề ị ệ ố ủ ố ố
 Ví d :ụ  =ABS(-17) -> 17

 Hàm INT
 Cú pháp: =INT(đ i s )ố ố
 Công d ng:ụ  Tr  v  ph n nguyên c a đ i s .ả ề ầ ủ ố ố
 Ví d :ụ  =INT(15,456) -> 15



2/ Các hàm toán h c (tt)ọ2/ Các hàm toán h c (tt)ọ
 Hàm MOD:

 Cú pháp: =MOD(đ i s  1; đ i s  2)ố ố ố ố
 Công d ng:ụ  Tr  v  s  d  khi th c hi n phép chia đ i s  ả ề ố ư ự ệ ố ố

1 cho đ i s  2.ố ố
 Ví d :ụ  =MOD(10;3) -> 1

 Hàm ROUND
 Cú pháp: =ROUND(Tham s ; V  trí)ố ị

 =0: Làm tròn t i v  trí d u th p phân.ạ ị ấ ậ
 >0: Làm đ n s  ch  s  l  đ c ch  đ nh.ế ố ữ ố ẽ ượ ỉ ị
 <0: Làm tròn  ph n nguyên v i s  ký s  b n ch  ra.ở ầ ớ ố ố ạ ỉ   

 Công d ng:ụ  Tr  v  giá tr  c a tham s  sau khi đã làm ả ề ị ủ ố
tròn

 Ví d :ụ
 =Round(65,617;0) -> 66
 =Round(65,617;2) -> 65,62
 =Round(65,617;-2) -> 100



2/ Các hàm toán h c (tt)ọ2/ Các hàm toán h c (tt)ọ
 Hàm SQRT

 Cú pháp: =SQRT(đ i s )ố ố
 Công d ng:ụ  Tr  v  căn b c 2 c a đ i s .ả ề ậ ủ ố ố
 Ví d :ụ  =SQRT(9) -> 3
 Chú ý: N u đ i s  là s  âm hàm s  tr  v  l i ế ố ố ố ẽ ả ề ỗ #NUM!



3/ Các hàm lu n lýậ3/ Các hàm lu n lýậ
 Hàm IF:

 Cú pháp: =IF(logical_test;value_if_true;value_if_false)
 Logical_test: đi u ki n đ  xét, logical có th  là k t qu  ề ệ ể ể ế ả

c a m t hàm lu n lý nh  AND, OR,...ủ ộ ậ ư
 Value_if_true: giá tr  tr  v  n u đi u ki n logical_test ị ả ề ế ề ệ

là TRUE.
 Value_if_false: giá tr  tr  v  n u đi u ki n logical_test ị ả ề ế ề ệ

là FALSE.
 Công d ng:ụ  N u ế bi u th c logicể ứ  đúng thì hàm IF tr  v  ả ề

đ i s  th  nhìố ố ứ , ng c l i n u ượ ạ ế bi u th c logicể ứ  sai thì 
hàm IF tr  v  ả ề đ i s  th  3.ố ố ứ

 Chú ý:
 Có th  có 7 hàm IF đ c l ng vào nhau đ  t o nên ể ượ ồ ể ạ

công th c ph c t p h n.ứ ứ ạ ơ
 Bi u th c đi u ki n ph i có giá tr  là TRUE ho c ể ứ ề ệ ả ị ặ

FALSE, n u không hàm IF tr  v  giá tr  ế ả ề ị #VALUE



3/ Các hàm lu n lý (tt)ậ3/ Các hàm lu n lý (tt)ậ
 Hàm IF: (tt)

 Ví d :ụ  =IF(3>5;“Sai”;“Đúng”)=?

 Hàm AND:
 Cú pháp: =AND(logical_1,logical_2,...)
logical_1,logical_2,... là các đ u ki n c n ki m tra.ề ệ ầ ể
 Công d ng:ụ  Tr  v  k t qu  TRUE n u t t c  đi u ki n ả ề ế ả ế ấ ả ề ệ

đ u TRUE, tr  v  FALSE n u m t trong các đi u ki n ề ả ề ế ộ ề ệ
FALSE.

 Ví d :ụ
 =AND(1>0; 2>=2; 4<5; 4<=3) ->FALSE
 =AND(1>0; 2>=2; 4<5; 4<=4) ->TRUE

 Hàm OR:
 Cú pháp: =OR(logical_1,logical_2,...)
 Công d ng: ụ Tr  v  TRUE n u m t trong các đi u ki n là ả ề ế ộ ề ệ

TRUE. Tr  v  FALSE n u t t c  các đi u ki n là FALSE.ả ề ế ấ ả ề ệ



3/ Các hàm lu n lý (tt)ậ3/ Các hàm lu n lý (tt)ậ
 Hàm OR: (tt)

 Ví d :ụ
 =OR(1>5; 2>=3; 4<4; 4<=3) ->FALSE
 =OR(1>0; 2>=3; 4>5; 4<=3) ->TRUE

 Hàm NOT:
 Cú pháp: =NOT(logical)
 Công d ng:ụ  Tr  v  ph  đ nh c a m t bi u th c Logicả ề ủ ị ủ ộ ể ứ
 Ví d :ụ  

 =NOT(2=2+1) ->TRUE
 =NOT(2<=2+1) ->FALSE



4/ Các hàm x  lý chu iử ỗ4/ Các hàm x  lý chu iử ỗ
 Hàm LEFT:

 Cú pháp: =LEFT(text;num_chars)
 text là chu i c n trích ký t .ỗ ầ ự
 num_chars là ký t  mà b n c n trích bên trái chu i ự ạ ầ ỗ

text.
 Công d ng:ụ  Trích bên trái m t chu i m t ho c nhi u ký ộ ỗ ộ ặ ề

t  d a vào s  ký t  mà b n ch  đ nh.ự ự ố ự ạ ỉ ị
 Chú ý:

 num_chars không ph i là s  âm.ả ố
 num_chars n u l n h n đ  dài c a chu i thì s  tr  v  ế ớ ơ ộ ủ ỗ ẽ ả ề

toàn b  chu i text.ộ ỗ
 num_chars n u b  qua thì m c đ nh là 1.ế ỏ ặ ị

 Ví d :ụ  =Left(“Trung tam tin hoc”; 5 ) -> Trung

 Hàm Right: T ng t  hàm Left nh ng s  rút trích s  ký t  ươ ự ư ẽ ố ự
bên ph i c a chu i.ả ủ ỗ



4/ Các hàm x  lý chu i (tt)ử ỗ4/ Các hàm x  lý chu i (tt)ử ỗ
 Hàm MID:

 Cú pháp: =MID(text;start_num,num_chars)
 Text: là chu i ho c tham chi u đ n chu i.ỗ ặ ế ế ỗ
 start_num: v  trí b t đ u trích l c chu i con trong ị ắ ầ ọ ỗ text.
 num_chars: s  ký t  c a chu i m i c n trích t  chu i ố ự ủ ỗ ớ ầ ừ ỗ

text.
 Công d ng: ụ Trích m t chu i con t  m t chu iộ ỗ ừ ộ ỗ  text, b t ắ

đ u t  v  trí ầ ừ ị start_num v i s  ký t  đ c ch  đ nh ớ ố ự ượ ỉ ị
num_chars.

 Chú ý:
 start_num: l n h n chi u dài chu i text thì hàm tr  v  ớ ơ ề ỗ ả ề

chu i r ng “”ỗ ỗ
 start_num: nh  h n 1 hàm tr  v  l i #VALUE!ỏ ơ ả ề ỗ
 num_chars: âm MID tr  v  l i #VALUE!ả ề ỗ

 Ví d :ụ  =MID(“Trung tam tin hoc”;11;7) -> tin hoc



4/ Các hàm x  lý chu i (tt)ử ỗ4/ Các hàm x  lý chu i (tt)ử ỗ
 Hàm LEN:

 Cú pháp: =LEN(Chu i s )ỗ ố
 Công d ng:ụ  Tr  v  đ  dài (s  ký t ) c a chu i s .ả ề ộ ố ự ủ ỗ ố

 Hàm VALUE:
 Cú pháp: =VALUE(Chu i s )ỗ ố
 Công d ng: ụ Đ i chu i s  ra thành d  li u ki u s .ổ ỗ ố ữ ệ ể ố



5/ Các hàm th ng kêố5/ Các hàm th ng kêố
 Hàm AVERAGE:

 Cú pháp: =AVERAGE(number1;number2;...)
number1,number2,… có th  có t  1 đ n 30 s  mà b n c n ể ừ ế ố ạ ầ

tính trung bình c ng.ộ  

 Công d ng:ụ Tính trung bình c ng c a các đ i s .ộ ủ ố ố  

 Hàm COUNT:
 Cú pháp: =COUNT(value1;value2;...)
value1,value2,... có th  có t  1 đ n 30 vùng giá tr  mà b n ể ừ ế ị ạ

mu n đ m s  ô ch a d  li u ki u s .ố ế ố ứ ữ ệ ể ố  

 Công d ng: ụ Đ m s  ô d  li u ki u s  trong vùng tham ế ố ữ ệ ể ố
chi u.ế

 Hàm MIN:
 Cú pháp: =MIN(number1;number2;...)
 Công d ng:ụ  Tr  v  s  nh  nh t trong các đ i s  truy n ả ề ố ỏ ấ ố ố ề

vào.



5/ Các hàm th ng kê (tt)ố5/ Các hàm th ng kê (tt)ố
 Hàm MAX: T ng t  hàm MIN nh ng se tr  v  s  ươ ự ư ả ề ố

l n nh t trong các đ i s  truy n vào.ớ ấ ố ố ề

 Hàm RANK:
 Cú pháp: =RANK(number; ref; order) 

 number giá tr  mà b n c n tìm v  th . ị ạ ầ ị ứ
 ref là m ng ho c vùng tham chi u đ n m t danh sách ả ặ ế ế ộ

giá tr  ki u s . Nh ng giá tr  không ph i là s  đ c b  ị ể ố ữ ị ả ố ượ ỏ
qua.

 order: ph ng th c s p x p:ươ ứ ắ ế
 order = 0, ho c b  qua thì s  l n nh t có v  trí nh  ặ ỏ ố ớ ấ ị ỏ

nh t (S p x p giam).ấ ắ ế
 order = 1 thì s  nh  nh t có v  trí nh  nh t (S p ố ỏ ấ ị ỏ ấ ắ

x p tăng).ế
 Công d ng:ụ  Tìm v  th  c a m t s  trong dãy s .ị ứ ủ ộ ố ố  



5/ Các hàm th ng kê (tt)ố5/ Các hàm th ng kê (tt)ố
 Hàm COUNTIF:

 Cú pháp: =COUNTIF(Dãy ki m tra; Đi u ki n)ể ề ệ
 Vùng ki m tra:ể  Là m t vùng ô.ộ
 Đi u ki n:ề ệ  Là đi u ki n đ  đ m, có th  là h ng s  hay ề ệ ể ế ể ằ ố

đ a ch  c a ô hay d ng th c “>16000”.ị ỉ ủ ạ ứ
 Công d ng:ụ  Hàm Countif tr  v  m t s  b ng cách tìm ả ề ộ ố ằ

trong Dãy ki m traể  có bao nhiêu ô th a mãn ỏ đi u ki n.ề ệ

 Hàm SUMIF:
 Cú pháp: =SUMIF(Dãy ki m tra; Đi u kiên; Dãy tính ể ề

t ng)ổ
 Dãy tính t ng:ổ  Tùy theo cách tính toán mà có th  có ể

dãy tính t ng hay không.ổ
 Công d ng:ụ  Tính t ng c a ổ ủ dãy tính t ngổ  tho  ả dãy ki m ể

tra đ i v i ố ớ đi u ki n.ề ệ



6/ Các hàm ngày tháng6/ Các hàm ngày tháng
 Hàm TODAY:

 Cú pháp: =TODAY()
 Công d ng: ụ Tr  v  ngày hi n t i trong h  th ng c a b n. ả ề ệ ạ ệ ố ủ ạ

N u đ nh d ng ô là General tr c khi hàm nh p công ế ị ạ ướ ậ
th c, k t qu  tr  v   đ nh d ng ngày tháng.ứ ế ả ả ề ở ị ạ

 Hàm DATE:
 Cú pháp: =DATE(year; month; day) 
 Công d ng:ụ  Tr  v  m t chu i ho c m t s  th  hi n m t ả ề ộ ỗ ặ ộ ố ể ệ ộ

ngày tháng đ y đ . N u đ nh d ng ô là ầ ủ ế ị ạ General tr c khi ướ
nh p hàm thì k t qu  tr  v  là chu i ngày tháng.ậ ế ả ả ề ỗ



6/ Các hàm ngày tháng (tt)6/ Các hàm ngày tháng (tt)
 Hàm DAY:

 Cú pháp: =DAY(serial_number)
 serial_number d ng chu i s  tu n t  c a ngày c n ạ ỗ ố ầ ự ủ ầ

tìm. Ngày tháng này nên nh p b ng hàm DATE ho c ậ ằ ặ
k t qu  tr  v  t  hàm khác.ế ả ả ề ừ

 Có th  b  l i n u b n nh p serial_number là m t chu i ể ị ỗ ế ạ ậ ộ ỗ
d ng văn b n.ạ ả

 Công d ngụ : Tr  v  th  t  c a ngày t  chu i ngày tháng.ả ề ứ ự ủ ừ ỗ

 Hàm Month và hàm Year: T ng t  nh  hàm ươ ự ư Day 
nh ng s  cho giá tr  ư ẽ ị tháng và năm.



7/ Các hàm tìm ki m & tham chi uế ế7/ Các hàm tìm ki m & tham chi uế ế
 Hàm VLOOKUP:

 Cú pháp: =VLOOKUP(Giá tr  dò tìmị ; B ng ch a giá tr  ả ứ ị
dò tìm; C t tr  v  c a b ng ch a giá tr  dò tìmộ ả ề ủ ả ứ ị ; Ki u dò ể
tìm)
 VLOOKUP xu t phát t  ấ ừ vertical lookup: dò tìm theo 

ph ng đ ng, hay theo c t.ươ ứ ộ
 Ki u dò tìm: Dùng ki u dò tìm là 0ể ể

 Công d ng: ụ Dò tìm m t giá tr   c t đ u tiên bên trái c a ộ ị ở ộ ầ ủ
m t b ng ch a giá tr  dò tìm. N u tìm th y s  tr  v  giá tr  ộ ả ứ ị ế ấ ẽ ả ề ị

 cùng trên cùng m t dòng v i giá tr  tìm th y trên c t mà ở ộ ớ ị ấ ộ
b n ch  đ nh. Hàm VLOOKUP th ng dùng đ  đi n thông ạ ỉ ị ườ ể ề
tin vào b ng d  li u t  b ng d  li u ph .ả ữ ệ ừ ả ữ ệ ụ

 Hàm HLOOKUP: T ng t  nh  hàm VLOOKUP nh ng lúc ươ ự ư ư
này dò tìm theo dòng.



7/ Các hàm tìm ki m & tham chi u (tt)ế ế7/ Các hàm tìm ki m & tham chi u (tt)ế ế
 Hàm INDEX:

 Cú pháp: =INDEX(array; row_num; column_num) 

 array: Là m t m ng ộ ả .

 row_num: Ch  s  dòng c n tr  v  giá tr .ỉ ố ầ ả ề ị
 colum_num: Ch  s  c t c n tr  v  giá tr .ỉ ố ộ ầ ả ề ị

 Công d ng:ụ Tr  v  m t giá tr  n m bên trong m t m ng ả ề ộ ị ằ ộ ả
d a vào ch  s  dòng và c t.ự ỉ ố ộ

 Hàm MATCH:
 Cú pháp: =MATCH(lookup_value; lookup_array; 

match_type)
 Lookup_value: Là giá tr  c n tìm trong b ng giá tr .ị ầ ả ị
 Lookup_array: Là m t dãy ô liên t c đ  tìm ki m giá ộ ụ ể ế

tr .ị
 Match_type: Dùng ki u dò tìm là 0.ể

 Công d ng: ụ Tr  v  v  trí (ch  m c) c a m t giá tr  t  m t ả ề ị ỉ ụ ủ ộ ị ừ ộ
dãy giá tr .ị



BÀI 6BÀI 6

C  S  D  LI U Ơ Ở Ữ ỆC  S  D  LI U Ơ Ở Ữ Ệ
TRÊN EXCELTRÊN EXCEL



I/ Khái ni m v  C  s  d  li uệ ề ơ ở ữ ệI/ Khái ni m v  C  s  d  li uệ ề ơ ở ữ ệ
 T p h p các thông tin v  m t đ i t ng đ c l u tr  ậ ợ ề ộ ố ượ ượ ư ữ

trên máy tính, nh m ph c v  cho công vi c qu n lý ằ ụ ụ ệ ả
hay truy xu t đ i t ng đó, đ c g i là c  s  d  li u ấ ố ượ ượ ọ ơ ở ữ ệ
(CSDL).

 M t CSDL bao g m m t ho c nhi u b n ghi ộ ồ ộ ặ ề ả
(Record) d  li u khác nhau, trong m i b n ghi có m t ữ ệ ỗ ả ộ
hay nhi u tr ng d  li u (Field).ề ườ ữ ệ



II/ T  ch c vùng đi u ki nổ ứ ề ệII/ T  ch c vùng đi u ki nổ ứ ề ệ
 Mu n rút trích d  li u theo m t đi u ki n nào đó t  ố ữ ệ ộ ề ệ ừ

CSDL c a Excel thì tr c h t ph i t o ủ ướ ế ả ạ vùng đi u ề
ki n.ệ

 Vùng đi u ki n ph i có t i thi u là m t dòng và m t ề ệ ả ố ể ộ ộ
c t. Đ c t  ch c nh  sau:ộ ượ ổ ứ ư

 N u ch  có m t đi u ki n (đi u ki n đ n):ế ỉ ộ ề ệ ề ệ ơ

 N u có nhi u đi u ki n cho cùng m t tr ng mang ế ề ề ệ ộ ườ
tính ch t ấ ho cặ :

Field

Đi u ki nề ệ

Field

Đi u ki n 1ề ệ

Đi u ki n 2ề ệ



II/ T  ch c vùng đi u ki nổ ứ ề ệII/ T  ch c vùng đi u ki nổ ứ ề ệ
 N u đi u ki n k t h p v i nhi u tr ng mang tính ế ề ệ ế ợ ớ ề ườ

ch t ấ và:

 N u đi u ki n k t h p v i nhi u tr ng mang tính ế ề ệ ế ợ ớ ề ườ
ch t ấ ho c:ặ

Field1 Field2

Đi u ki n 1ề ệ Đi u ki n 2ề ệ

Field1 Field2

Đi u ki n 1ề ệ

Đi u ki n 2ề ệ



III/ Rút trích d  li uữ ệIII/ Rút trích d  li uữ ệ
 Đ t con tr  vào vùng d  li u c n rút trích.ặ ỏ ữ ệ ầ
 Vào menu Data -> Filter -> Advanced Filter

 Filter the list, in-place: 
K t qu  rút trích s  xu t hi n ế ả ẽ ấ ệ
ngay trên CSDL ban đ u.ầ

 Copy to another location: 
Ch n n i khác đ  th  hi n ọ ơ ể ể ệ
k t qu  rút trích.ế ả

 List range: Ch n vùng ọ
CSDL ban đ u.ầ

 Criteria range: Ch n vùng ọ
đi u ki n rút trích.ề ệ

 Copy to: Ch n n i c n th  hi n k t qu  rút trích.ọ ơ ầ ể ệ ế ả



IV/ Tìm ki m/L c d  li uế ọ ữ ệIV/ Tìm ki m/L c d  li uế ọ ữ ệ
 Vào menu Data -> Filter -> Autofilter -> T t c  các ấ ả

tr ng trong CSDL s  đ c th  hi n d i d ng m t ườ ẽ ượ ể ệ ướ ạ ộ
Combo Box g m m t danh sách các giá tr  đ c l c ồ ộ ị ượ ọ
t  đ ng trong các giá tr  hi n t i nó đang ch a. ự ộ ị ệ ạ ứ
Thông qua các Combo Box này, ng i dùng có th  ườ ể
tìm ki m ho c trích l c thông tin m t cách nhanh ế ặ ọ ộ
chóng.
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IN N VÀ B O V  Ấ Ả ỆIN N VÀ B O V  Ấ Ả Ệ
B NG TÍNH ẢB NG TÍNH Ả



I/ Cài đ t trang inặI/ Cài đ t trang inặ
 Vào menu File -> Page Setup...Tab Page

In theo 
chi u d cề ọ

In theo chi u ề
ngang

T  l  inỉ ệ

Thu nh  n i ỏ ộ
dung đ  in ể

vào s  trang ố
quy đ nhị



I/ Cài đ t trang in (tt)ặI/ Cài đ t trang in (tt)ặ
 Tab Margin:

 Top: l  trênề

 Left: L  tráiề

 Right: L  ph iề ả

 Bottom: L  d iề ướ

 Header: Kho ng ả
cách t  l  trên gi y ừ ề ấ
đ n tiêu đ  đ u.ế ề ầ

 Footer: Kho ng ả
cách t  l  trên gi y ừ ề ấ
đ n tiêu đ  đ u.ế ề ầ Canh gi a n i ữ ộ

dung theo 
chi u ngangề

Canh gi a n i ữ ộ
dung theo 
chi u d cề ọ



I/ Cài đ t trang in (tt)ặI/ Cài đ t trang in (tt)ặ
 Tab Header/Footer:

Ch n tiêu đ  ọ ề
đ u trang t  ầ ừ
các l a ch n ự ọ

có s nẵ

Ch n tiêu đ  ọ ề
chân trang t  các ừ
l a ch n có s nự ọ ẵ

Tiêu đ  đ u trang ề ầ
do ng i s  d ng ườ ử ụ

quy đinh

Tiêu đ  chân ề
trang do ng i ườ

s  d ng quy đinhử ụ



I/ Cài đ t trang in (tt)ặI/ Cài đ t trang in (tt)ặ
 Tab Header/Footer:
 Print Area: Vùng d  li u c n in.ữ ệ ầ
 Row to repeat at top: In l i tiêu ạ
đ  dòng.ề
 Columns to repeat at left: In l i ạ
tiêu đ  c t.ề ộ
 Girdlines: In đ ngườ  l iướ  cua ̉
Excel.
 Black and White: Chi in ph n văn b̉ ầ nả , không in màu nên.̀  

 Draft quality: Không in các đ ng vi n do ng i s  d ng k .ườ ề ườ ử ụ ẻ

 Row and column headings: In tiêu đê d̀ òng và côt.̣

 Down, then over: In từ trên xuồ ́ng d iướ , sau đó qua ph i.ả

 Over, then down : In t  tráiừ  sang ph iả , sau đó xuông ́ d i.ướ



II/ Xem tr c khi inướII/ Xem tr c khi inướ
 Vào menu File -> Print Preview



II/ Xem tr c khi inướII/ Xem tr c khi inướ
 Thanh công c  ụ Print Preview:

Phóng to, 
thu nhỏ

Sang trang 
ti pế

Th c ự
hi n inệV  trang ề

tr cướ

Đ nh d ng ị ạ
l i trang ạ

in

Hi n th  các ể ị
đ ng lườ ề

Hi n th  ch  ể ị ế
đ  ng t trangộ ắ

Đóng 
c a sử ổ

Tr  giúpợ



III/ B o v  b ng tínhả ệ ảIII/ B o v  b ng tínhả ệ ả
 Đây là m t ti n ích c a Excel giúp cho b ng tính c a ộ ệ ủ ả ủ

ng i s  d ng không b  ng i khác s a đ i công ườ ử ụ ị ườ ử ổ
th c ho c không xem đ c công th c.ứ ặ ượ ứ

 Đ  b o v  Worksheet nào thì đ ng  Worksheet đó. ể ả ệ ứ ở
Vào menu Tools -> Protection -> Protect Sheet... 
Đi n m t kh u b o v ...ề ậ ẩ ả ệ

 Khi đã b o v  b ng cách nh  trên thì ng i khác s  ả ệ ằ ư ườ ẽ
không th  s a đ i đ c công th c trên trang b ng tính ể ử ổ ượ ứ ả
(v n có th  xem đ c công th c).ẫ ể ượ ứ

 Đ  cho ng i khác không th  xem đ c công th c ể ườ ể ượ ứ
trên ô hay trên thanh công th c thì tr c khi làm thao ứ ướ
tác nh  trên hãy ch n nh ng ô nào mu n n công ư ọ ữ ố ẩ
th c và vào menu ứ Format -> Cells...Qua tab 
Protection, check vào m c ụ Hidden.
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